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The information provided in this documentation contains general descriptions and/or technical 
characteristics of the performance of the products contained herein. This documentation is not 
intended as a substitute for and is not to be used for determining suitability or reliability of these 
products for specific user applications. It is the duty of any such user or integrator to perform the 
appropriate and complete risk analysis, evaluation and testing of the products with respect to the 
relevant specific application or use thereof. Neither Schneider Electric nor any of its affiliates or 
subsidiaries shall be responsible or liable for misuse of the information contained herein. If you 
have any suggestions for improvements or amendments or have found errors in this publication, 
please notify us. 
You agree not to reproduce, other than for your own personal, noncommercial use, all or part of 
this document on any medium whatsoever without permission of Schneider Electric, given in 
writing. You also agree not to establish any hypertext links to this document or its content. 
Schneider Electric does not grant any right or license for the personal and noncommercial use of 
the document or its content, except for a non-exclusive license to consult it on an "as is" basis, at 
your own risk. All other rights are reserved.
All pertinent state, regional, and local safety regulations must be observed when installing and 
using this product. For reasons of safety and to help ensure compliance with documented system 
data, only the manufacturer should perform repairs to components.
When devices are used for applications with technical safety requirements, the relevant 
instructions must be followed. 
Failure to use Schneider Electric software or approved software with our hardware products may 
result in injury, harm, or improper operating results.
Failure to observe this information can result in injury or equipment damage.
© 2019 Schneider Electric. All rights reserved.
2 EIO0000002980 06/2019
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Safety Information
Important Information

NOTICE
Read these instructions carefully, and look at the equipment to become familiar with the device 
before trying to install, operate, service, or maintain it. The following special messages may appear 
throughout this documentation or on the equipment to warn of potential hazards or to call attention 
to information that clarifies or simplifies a procedure.
EIO0000002980 06/2019 5



PLEASE NOTE
Electrical equipment should be installed, operated, serviced, and maintained only by qualified 
personnel. No responsibility is assumed by Schneider Electric for any consequences arising out of 
the use of this material.
A qualified person is one who has skills and knowledge related to the construction and operation 
of electrical equipment and its installation, and has received safety training to recognize and avoid 
the hazards involved.

BEFORE YOU BEGIN
Do not use this product on machinery lacking effective point-of-operation guarding. Lack of 
effective point-of-operation guarding on a machine can result in serious injury to the operator of 
that machine.

This automation equipment and related software is used to control a variety of industrial processes. 
The type or model of automation equipment suitable for each application will vary depending on 
factors such as the control function required, degree of protection required, production methods, 
unusual conditions, government regulations, etc. In some applications, more than one processor 
may be required, as when backup redundancy is needed.
Only you, the user, machine builder or system integrator can be aware of all the conditions and 
factors present during setup, operation, and maintenance of the machine and, therefore, can 
determine the automation equipment and the related safeties and interlocks which can be properly 
used. When selecting automation and control equipment and related software for a particular 
application, you should refer to the applicable local and national standards and regulations. The 
National Safety Council's Accident Prevention Manual (nationally recognized in the United States 
of America) also provides much useful information.
In some applications, such as packaging machinery, additional operator protection such as point-
of-operation guarding must be provided. This is necessary if the operator's hands and other parts 
of the body are free to enter the pinch points or other hazardous areas and serious injury can occur. 
Software products alone cannot protect an operator from injury. For this reason the software 
cannot be substituted for or take the place of point-of-operation protection.
Ensure that appropriate safeties and mechanical/electrical interlocks related to point-of-operation 
protection have been installed and are operational before placing the equipment into service. All 
interlocks and safeties related to point-of-operation protection must be coordinated with the related 
automation equipment and software programming.

WARNING
UNGUARDED EQUIPMENT
 Do not use this software and related automation equipment on equipment which does not have 

point-of-operation protection.
 Do not reach into machinery during operation.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
6 EIO0000002980 06/2019



NOTE: Coordination of safeties and mechanical/electrical interlocks for point-of-operation 
protection is outside the scope of the Function Block Library, System User Guide, or other 
implementation referenced in this documentation.

START-UP AND TEST
Before using electrical control and automation equipment for regular operation after installation, 
the system should be given a start-up test by qualified personnel to verify correct operation of the 
equipment. It is important that arrangements for such a check be made and that enough time is 
allowed to perform complete and satisfactory testing.

Follow all start-up tests recommended in the equipment documentation. Store all equipment 
documentation for future references.
Software testing must be done in both simulated and real environments.
Verify that the completed system is free from all short circuits and temporary grounds that are not 
installed according to local regulations (according to the National Electrical Code in the U.S.A, for 
instance). If high-potential voltage testing is necessary, follow recommendations in equipment 
documentation to prevent accidental equipment damage.
Before energizing equipment:
 Remove tools, meters, and debris from equipment.
 Close the equipment enclosure door.
 Remove all temporary grounds from incoming power lines.
 Perform all start-up tests recommended by the manufacturer.

WARNING
EQUIPMENT OPERATION HAZARD
 Verify that all installation and set up procedures have been completed.
 Before operational tests are performed, remove all blocks or other temporary holding means 

used for shipment from all component devices.
 Remove tools, meters, and debris from equipment.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
EIO0000002980 06/2019 7



OPERATION AND ADJUSTMENTS
The following precautions are from the NEMA Standards Publication ICS 7.1-1995 (English 
version prevails):
 Regardless of the care exercised in the design and manufacture of equipment or in the selection 

and ratings of components, there are hazards that can be encountered if such equipment is 
improperly operated.

 It is sometimes possible to misadjust the equipment and thus produce unsatisfactory or unsafe 
operation. Always use the manufacturer’s instructions as a guide for functional adjustments. 
Personnel who have access to these adjustments should be familiar with the equipment 
manufacturer’s instructions and the machinery used with the electrical equipment.

 Only those operational adjustments actually required by the operator should be accessible to 
the operator. Access to other controls should be restricted to prevent unauthorized changes in 
operating characteristics.
8 EIO0000002980 06/2019



About the Book
At a Glance

Document Scope
This document describes a method to connect with your controller for which the latest version of 
the project is available and usable directly from the controller and not only from your PC servers.
The following knowledge is required:
 programming in the FBD, LD, ST, IL or CFC language
 information on functionality, structure and configuration of the controllers
 information in using of USB memory key or gateway

Validity Note

This document has been updated for the release of EcoStruxureTM Machine Expert V1.1.

Related Documents

Title of Documentation Reference Number
Modicon M241 Logic Controller Hardware Guide EIO0000001456 (ENG);

EIO0000001457 (FRE);
EIO0000001458 (GER);
EIO0000001459 (SPA);
EIO0000001460 (ITA);
EIO0000001461 (CHS)

Modicon M251 Logic Controller Hardware Guide EIO0000001486 (ENG); 
EIO0000001487 (FRE); 
EIO0000001488 (GER); 
EIO0000001489 (SPA); 
EIO0000001490 (ITA); 
EIO0000001491 (CHS)

Modicon M258 Logic Controller Hardware Guide EIO0000000432 (ENG);
EIO0000000433 (FRE);
EIO0000000434 (GER);
EIO0000000435 (SPA);
EIO0000000436 (ITA);
EIO0000000437 (CHS)
EIO0000002980 06/2019 9
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You can download these technical publications and other technical information from our website 
at https://www.schneider-electric.com/en/download

Product Related Information

1 For additional information, refer to NEMA ICS 1.1 (latest edition), "Safety Guidelines for the 
Application, Installation, and Maintenance of Solid State Control" and to NEMA ICS 7.1 (latest 
edition), "Safety Standards for Construction and Guide for Selection, Installation and Operation of 
Adjustable-Speed Drive Systems" or their equivalent governing your particular location.

Modicon LMC058 Motion Controller Hardware Guide EIO0000000438 (ENG);
EIO0000000439 (FRE);
EIO0000000440 (GER);
EIO0000000441 (SPA);
EIO0000000442 (ITA);
EIO0000000443 (CHS)

Modicon LMC078 Motion Controller Hardware Guide EIO0000001925 (ENG); 
EIO0000001926 (FRE); 
EIO0000001927 (GER); 
EIO0000001928 (SPA); 
EIO0000001929 (ITA); 
EIO0000001930 (CHS)
EIO0000001932 (TUR)

Title of Documentation Reference Number

WARNING
LOSS OF CONTROL
 The designer of any control scheme must consider the potential failure modes of control paths 

and, for certain critical control functions, provide a means to achieve a safe state during and 
after a path failure. Examples of critical control functions are emergency stop and overtravel 
stop, power outage and restart.

 Separate or redundant control paths must be provided for critical control functions.
 System control paths may include communication links. Consideration must be given to the 

implications of unanticipated transmission delays or failures of the link.
 Observe all accident prevention regulations and local safety guidelines.1
 Each implementation of this equipment must be individually and thoroughly tested for proper 

operation before being placed into service.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
10 EIO0000002980 06/2019
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Terminology Derived from Standards
The technical terms, terminology, symbols and the corresponding descriptions in this manual, or 
that appear in or on the products themselves, are generally derived from the terms or definitions 
of international standards.
In the area of functional safety systems, drives and general automation, this may include, but is not 
limited to, terms such as safety, safety function, safe state, fault, fault reset, malfunction, failure, 
error, error message, dangerous, etc.
Among others, these standards include:

WARNING
UNINTENDED EQUIPMENT OPERATION
 Only use software approved by Schneider Electric for use with this equipment.
 Update your application program every time you change the physical hardware configuration.
Failure to follow these instructions can result in death, serious injury, or equipment damage.

Standard Description
IEC 61131-2:2007 Programmable controllers, part 2: Equipment requirements and tests.
ISO 13849-1:2015 Safety of machinery: Safety related parts of control systems.

General principles for design.
EN 61496-1:2013 Safety of machinery: Electro-sensitive protective equipment.

Part 1: General requirements and tests.
ISO 12100:2010 Safety of machinery - General principles for design - Risk assessment and risk 

reduction
EN 60204-1:2006 Safety of machinery - Electrical equipment of machines - Part 1: General 

requirements
ISO 14119:2013 Safety of machinery - Interlocking devices associated with guards - Principles 

for design and selection
ISO 13850:2015 Safety of machinery - Emergency stop - Principles for design
IEC 62061:2015 Safety of machinery - Functional safety of safety-related electrical, electronic, 

and electronic programmable control systems
IEC 61508-1:2010 Functional safety of electrical/electronic/programmable electronic safety-

related systems: General requirements.
IEC 61508-2:2010 Functional safety of electrical/electronic/programmable electronic safety-

related systems: Requirements for electrical/electronic/programmable 
electronic safety-related systems.

IEC 61508-3:2010 Functional safety of electrical/electronic/programmable electronic safety-
related systems: Software requirements.

IEC 61784-3:2016 Industrial communication networks - Profiles - Part 3: Functional safety 
fieldbuses - General rules and profile definitions.
EIO0000002980 06/2019 11



In addition, terms used in the present document may tangentially be used as they are derived from 
other standards such as:

Finally, the term zone of operation may be used in conjunction with the description of specific 
hazards, and is defined as it is for a hazard zone or danger zone in the Machinery Directive 
(2006/42/EC) and ISO 12100:2010.
NOTE: The aforementioned standards may or may not apply to the specific products cited in the 
present documentation. For more information concerning the individual standards applicable to the 
products described herein, see the characteristics tables for those product references.

2006/42/EC Machinery Directive
2014/30/EU Electromagnetic Compatibility Directive
2014/35/EU Low Voltage Directive

Standard Description
IEC 60034 series Rotating electrical machines
IEC 61800 series Adjustable speed electrical power drive systems
IEC 61158 series Digital data communications for measurement and control – Fieldbus for use in 

industrial control systems

Standard Description
12 EIO0000002980 06/2019



EcoStruxure Machine Expert

EIO0000002980 06/2019
Short Description

Overview
This document describes a method to connect with your controller for which the latest version of 
the project is available and usable directly from the controller and not only from your PC servers.

System Requirements and Limitations
The procedure has been tested with the components listed in the table:

Example Overview
Download and upload source code operation allows you to save your project source code onto a 
controller and to retrieve it later on. With this retrieved EcoStruxure Machine Expert project file, you 
can connect to the controller without the need to first load the application into EcoStruxure Machine 
Expert, for example, for maintenance purposes.
NOTE: You must maintain the coherency between the source code of the application and the 
compiled object code of the application. If you modify the source code, be sure to compile the 
application and download it as well to the controller.
The following table gives an overview of the procedure steps:

Component Type and Version
Software EcoStruxure Machine Expert V1.0 or greater
Controller  Modicon M241 Logic Controller

 Modicon M251 Logic Controller
 Modicon M258 Logic Controller
 Modicon LMC078 Motion Controller

Additional devices RJ45 connector

NOTE: The concepts presented in the example procedure are 
transferable to other programming port connections of your controller.

Step Description Graphical display
1 Develop and download your application to your 

controller.
EIO0000002980 06/2019  EcoStruxure Machine Expert version 1.1 does not support the M258, LMC058 and LMC078 controllers. 13



Hardware Configuration

Overview
Refer to the hardware guide of your controller (see page 9) to connect your controller.

Transfer Procedures

Downloading the Source Code of the Project to the Controller
Downloading the source code as described in the following steps:

2 Download the project source code to the controller 
(see page 14).

3 Later on, you might have the need to modify the 
project, or to maintain it.
 Upload the project source code from the controller 

to EcoStruxure Machine Expert.
 Connect with the uploaded project to the controller.
 Modify the uploaded project and perform Online 

changes (see EcoStruxure Machine Expert, 
Programming Guide).

4 Download the project source code after modifying. –

Step Description Graphical display
14   EcoStruxure Machine Expert version 1.1 does not support the M258, LMC058 and LMC078 controllers. EIO0000002980 06/2019



Step Action
1 Create or open your project.
2 Open the project settings in the Logic Builder with Project →  Project Settings....
3 Select Source Download and clear the check box Use compact download.

Optionally, in the Timing area you can activate the option Implicity at creating bootproject so that the 
source download is executed at each boot project creation.

NOTE: Other options are available, refer to the Project Settings... →  Source Download dialog box.

Click on the Additional files... button and activate the check box Download information files.

NOTE: Select the options Referenced devices, Referenced libraries, in case your project contains 
libraries or devices not delivered with EcoStruxure Machine Expert, or if download and upload source are 
planned to be performed from different EcoStruxure Machine Expert installations (on different PCs). 
Select Library Profile and Visualization Profile to perform download and upload source by using different 
EcoStruxure Machine Expert versions.

4 Click OK twice to exit the windows.
5 Select Online →  Create boot application.

Result: The boot project is created and the source code is downloaded.

NOTE: If you activated in step 3 the option Only on demand in the Timing area, you have to do it 
manually:
1. Select File →  Source download....

Result: The Controller selection view opens.
2. Double-click the controller from the list where the sources shall be downloaded to.

The node name at the bottom must correspond to the chosen controller at the top of the window.
3. Click OK.

Result: The progress of the source download will be indicated in the status bar.
6 In the controller device editor, open the Files tab to verify that the source project has been downloaded.

Result: The new archive.prj file has been created.
Verify the modification date of the file.
EIO0000002980 06/2019  EcoStruxure Machine Expert version 1.1 does not support the M258, LMC058 and LMC078 controllers. 15



Upload your Project from the Controller
Upload your project from the controller as described in the following steps:

Step Action
1 Close your project in EcoStruxure Machine Expert.
2 Connect the controller to the PC.

Result: The Select Controller dialog box opens, and the Ethernet network and the USB ports are scanned 
for available controllers.

3 Select your controller in the displayed list and click the Select button.
4 In the Options dialog box, select the option Upload project from controller and click Continue.

Result: After a brief delay, the Project Archive dialog box opens.
5 Choose an empty folder where you want to copy the extracted elements from your controller and click 

Extract.
Result: A message is displayed, if you want to open the project in EcoStruxure Machine Expert.

6 Click Yes.
Result: When the system is ready, the Logic Builder button is active.

7 Click the Logic Builder button.
Result: Your uploaded project is opened in the Logic Builder.

8 Login to your controller.
16   EcoStruxure Machine Expert version 1.1 does not support the M258, LMC058 and LMC078 controllers. EIO0000002980 06/2019
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The information provided in this documentation contains general descriptions and/or technical 
characteristics of the performance of the products contained herein. This documentation is not 
intended as a substitute for and is not to be used for determining suitability or reliability of these 
products for specific user applications. It is the duty of any such user or integrator to perform the 
appropriate and complete risk analysis, evaluation and testing of the products with respect to the 
relevant specific application or use thereof. Neither Schneider Electric nor any of its affiliates or 
subsidiaries shall be responsible or liable for misuse of the information contained herein. If you 
have any suggestions for improvements or amendments or have found errors in this publication, 
please notify us. 
You agree not to reproduce, other than for your own personal, noncommercial use, all or part of 
this document on any medium whatsoever without permission of Schneider Electric, given in 
writing. You also agree not to establish any hypertext links to this document or its content. 
Schneider Electric does not grant any right or license for the personal and noncommercial use of 
the document or its content, except for a non-exclusive license to consult it on an "as is" basis, at 
your own risk. All other rights are reserved.
All pertinent state, regional, and local safety regulations must be observed when installing and 
using this product. For reasons of safety and to help ensure compliance with documented system 
data, only the manufacturer should perform repairs to components.
When devices are used for applications with technical safety requirements, the relevant 
instructions must be followed. 
Failure to use Schneider Electric software or approved software with our hardware products may 
result in injury, harm, or improper operating results.
Failure to observe this information can result in injury or equipment damage.
© 2019 Schneider Electric. All rights reserved.
2 EIO0000004051 12/2019
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Safety Information
Important Information

NOTICE
Read these instructions carefully, and look at the equipment to become familiar with the device 
before trying to install, operate, service, or maintain it. The following special messages may appear 
throughout this documentation or on the equipment to warn of potential hazards or to call attention 
to information that clarifies or simplifies a procedure.
EIO0000004051 12/2019 5



PLEASE NOTE
Electrical equipment should be installed, operated, serviced, and maintained only by qualified 
personnel. No responsibility is assumed by Schneider Electric for any consequences arising out of 
the use of this material.
A qualified person is one who has skills and knowledge related to the construction and operation 
of electrical equipment and its installation, and has received safety training to recognize and avoid 
the hazards involved.

BEFORE YOU BEGIN
Do not use this product on machinery lacking effective point-of-operation guarding. Lack of 
effective point-of-operation guarding on a machine can result in serious injury to the operator of 
that machine.

This automation equipment and related software is used to control a variety of industrial processes. 
The type or model of automation equipment suitable for each application will vary depending on 
factors such as the control function required, degree of protection required, production methods, 
unusual conditions, government regulations, etc. In some applications, more than one processor 
may be required, as when backup redundancy is needed.
Only you, the user, machine builder or system integrator can be aware of all the conditions and 
factors present during setup, operation, and maintenance of the machine and, therefore, can 
determine the automation equipment and the related safeties and interlocks which can be properly 
used. When selecting automation and control equipment and related software for a particular 
application, you should refer to the applicable local and national standards and regulations. The 
National Safety Council's Accident Prevention Manual (nationally recognized in the United States 
of America) also provides much useful information.
In some applications, such as packaging machinery, additional operator protection such as point-
of-operation guarding must be provided. This is necessary if the operator's hands and other parts 
of the body are free to enter the pinch points or other hazardous areas and serious injury can occur. 
Software products alone cannot protect an operator from injury. For this reason the software 
cannot be substituted for or take the place of point-of-operation protection.
Ensure that appropriate safeties and mechanical/electrical interlocks related to point-of-operation 
protection have been installed and are operational before placing the equipment into service. All 
interlocks and safeties related to point-of-operation protection must be coordinated with the related 
automation equipment and software programming.

WARNING
UNGUARDED EQUIPMENT
 Do not use this software and related automation equipment on equipment which does not have 

point-of-operation protection.
 Do not reach into machinery during operation.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
6 EIO0000004051 12/2019



NOTE: Coordination of safeties and mechanical/electrical interlocks for point-of-operation 
protection is outside the scope of the Function Block Library, System User Guide, or other 
implementation referenced in this documentation.

START-UP AND TEST
Before using electrical control and automation equipment for regular operation after installation, 
the system should be given a start-up test by qualified personnel to verify correct operation of the 
equipment. It is important that arrangements for such a check be made and that enough time is 
allowed to perform complete and satisfactory testing.

Follow all start-up tests recommended in the equipment documentation. Store all equipment 
documentation for future references.
Software testing must be done in both simulated and real environments.
Verify that the completed system is free from all short circuits and temporary grounds that are not 
installed according to local regulations (according to the National Electrical Code in the U.S.A, for 
instance). If high-potential voltage testing is necessary, follow recommendations in equipment 
documentation to prevent accidental equipment damage.
Before energizing equipment:
 Remove tools, meters, and debris from equipment.
 Close the equipment enclosure door.
 Remove all temporary grounds from incoming power lines.
 Perform all start-up tests recommended by the manufacturer.

WARNING
EQUIPMENT OPERATION HAZARD
 Verify that all installation and set up procedures have been completed.
 Before operational tests are performed, remove all blocks or other temporary holding means 

used for shipment from all component devices.
 Remove tools, meters, and debris from equipment.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
EIO0000004051 12/2019 7



OPERATION AND ADJUSTMENTS
The following precautions are from the NEMA Standards Publication ICS 7.1-1995 (English 
version prevails):
 Regardless of the care exercised in the design and manufacture of equipment or in the selection 

and ratings of components, there are hazards that can be encountered if such equipment is 
improperly operated.

 It is sometimes possible to misadjust the equipment and thus produce unsatisfactory or unsafe 
operation. Always use the manufacturer’s instructions as a guide for functional adjustments. 
Personnel who have access to these adjustments should be familiar with the equipment 
manufacturer’s instructions and the machinery used with the electrical equipment.

 Only those operational adjustments actually required by the operator should be accessible to 
the operator. Access to other controls should be restricted to prevent unauthorized changes in 
operating characteristics.
8 EIO0000004051 12/2019



About the Book
At a Glance

Document Scope
This document describes the steps for encrypting and decrypting your EcoStruxure Machine 
Expert projects using Windows certificates to help protect the source code they contain.

Validity Note

This document has been updated for the release of EcoStruxureTM Machine Expert V1.2.

Related Documents

Product Related Information

Document title Reference
EcoStruxure Machine Expert Programming Guide EIO0000002854 (ENG);

EIO0000002855 (FRE);
EIO0000002856 (GER);
EIO0000002858 (SPA);
EIO0000002857 (ITA);
EIO0000002859 (CHS)

WARNING
LOSS OF CONTROL
 The designer of any control scheme must consider the potential failure modes of control paths 

and, for certain critical control functions, provide a means to achieve a safe state during and 
after a path failure. Examples of critical control functions are emergency stop and overtravel 
stop, power outage and restart.

 Separate or redundant control paths must be provided for critical control functions.
 System control paths may include communication links. Consideration must be given to the 

implications of unanticipated transmission delays or failures of the link.
 Observe all accident prevention regulations and local safety guidelines.1
 Each implementation of this equipment must be individually and thoroughly tested for proper 

operation before being placed into service.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
EIO0000004051 12/2019 9
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1 For additional information, refer to NEMA ICS 1.1 (latest edition), "Safety Guidelines for the 
Application, Installation, and Maintenance of Solid State Control" and to NEMA ICS 7.1 (latest 
edition), "Safety Standards for Construction and Guide for Selection, Installation and Operation of 
Adjustable-Speed Drive Systems" or their equivalent governing your particular location.

Terminology Derived from Standards
The technical terms, terminology, symbols and the corresponding descriptions in this manual, or 
that appear in or on the products themselves, are generally derived from the terms or definitions 
of international standards.
In the area of functional safety systems, drives and general automation, this may include, but is not 
limited to, terms such as safety, safety function, safe state, fault, fault reset, malfunction, failure, 
error, error message, dangerous, etc.
Among others, these standards include:

WARNING
UNINTENDED EQUIPMENT OPERATION
 Only use software approved by Schneider Electric for use with this equipment.
 Update your application program every time you change the physical hardware configuration.
Failure to follow these instructions can result in death, serious injury, or equipment damage.

Standard Description
IEC 61131-2:2007 Programmable controllers, part 2: Equipment requirements and tests.
ISO 13849-1:2015 Safety of machinery: Safety related parts of control systems.

General principles for design.
EN 61496-1:2013 Safety of machinery: Electro-sensitive protective equipment.

Part 1: General requirements and tests.
ISO 12100:2010 Safety of machinery - General principles for design - Risk assessment and risk 

reduction
EN 60204-1:2006 Safety of machinery - Electrical equipment of machines - Part 1: General 

requirements
ISO 14119:2013 Safety of machinery - Interlocking devices associated with guards - Principles 

for design and selection
ISO 13850:2015 Safety of machinery - Emergency stop - Principles for design
IEC 62061:2015 Safety of machinery - Functional safety of safety-related electrical, electronic, 

and electronic programmable control systems
IEC 61508-1:2010 Functional safety of electrical/electronic/programmable electronic safety-

related systems: General requirements.
IEC 61508-2:2010 Functional safety of electrical/electronic/programmable electronic safety-

related systems: Requirements for electrical/electronic/programmable 
electronic safety-related systems.
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In addition, terms used in the present document may tangentially be used as they are derived from 
other standards such as:

Finally, the term zone of operation may be used in conjunction with the description of specific 
hazards, and is defined as it is for a hazard zone or danger zone in the Machinery Directive 
(2006/42/EC) and ISO 12100:2010.
NOTE: The aforementioned standards may or may not apply to the specific products cited in the 
present documentation. For more information concerning the individual standards applicable to the 
products described herein, see the characteristics tables for those product references.

IEC 61508-3:2010 Functional safety of electrical/electronic/programmable electronic safety-
related systems: Software requirements.

IEC 61784-3:2016 Industrial communication networks - Profiles - Part 3: Functional safety 
fieldbuses - General rules and profile definitions.

2006/42/EC Machinery Directive
2014/30/EU Electromagnetic Compatibility Directive
2014/35/EU Low Voltage Directive

Standard Description
IEC 60034 series Rotating electrical machines
IEC 61800 series Adjustable speed electrical power drive systems
IEC 61158 series Digital data communications for measurement and control – Fieldbus for use in 

industrial control systems

Standard Description
EIO0000004051 12/2019 11
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How To Help Protect Your Source Code

EIO0000004051 12/2019
Protecting Projects by Encryption Using Certificates

General Information on Certificates
When you need to protect the privacy of an EcoStruxure Machine Expert project, encrypt it. 
Encrypting a project in EcoStruxure Machine Expert means that you convert a project file into an 
unintelligible form that can only be deciphered in a system employing public and private keys. The 
keys are simply large numbers that have been paired together but are not the same between the 
public and private keys. This system is therefore referred to as Asymmetric Cryptography.
One key, the public key, can be shared with everyone; the other key is to be kept secret and is 
referred to as the private key. Either key can be used for encryption, but it requires the opposite 
key used for encryption to decrypt the file.
Without the corresponding key, you cannot open the project with EcoStruxure Machine Expert and 
the content of the project file is meaningless. Normally, you would use a private key to encrypt the 
file, and then use public keys distributed to others to decrypt the file.
Private and public keys are managed by certificates. On the Windows PC certificates with public 

keys are shown with a certificate icon . If the certificate additionally includes a private key it 

is also marked with a key symbol .
Certificates with a private key remain on your computer and should be kept safe from unauthorized 
access. The public key can be freely installed on other PCs.
If you want to encrypt and decrypt projects, the certificates must be installed on your PC. 
Additionally, all users that want to open the project on other PCs must have at least the public key 
installed on their PC. To do this, you can export a certificate with a public key from your private key 
certificate in the Windows settings Manage user certificates. Then you can give the certificate with 
the public key to others, for example, via Email.

Encrypting a Project

Overview
To help protect an EcoStruxure Machine Expert project by using certificates, perform the following 
steps in the EcoStruxure Machine Expert Logic Builder:
 Activating the Certificates option in the Project Settings → Security dialog box.
 Adding certificates to a project.
EIO0000004051 12/2019 13



Activating the Certificates Option in the Project Settings → Security Dialog Box

The graphic indicates the Project Settings → Security dialog box with Certificates option selected:

Step Action
1 Open the EcoStruxure Machine Expert project you want to encrypt.
2 Execute the Project → Project Settings command, and select the Security dialog box.

Alternatively, click the  button from the Project file encryption section of the View → 
Security Screen editor to open the Project → Project Settings → Security dialog box.

3 Activate the Enable project file encryption option.
4 Activate the Certificates option.
14 EIO0000004051 12/2019



Adding Certificates to a Project
To assign certificates to encrypt the open project, proceed as follows:

NOTE: You need a private key to open the project after it has been encrypted with a public key. In 
general, it is a good practice to encrypt projects using a private key and decrypt projects using a 
corresponding public key.
NOTE: If your private key certificate is lost or the certificate becomes outdated, and the project is 
encrypted with the public key, then the project cannot be decrypted and cannot be opened any 
more, nor can the file contents be restored.

Step Action Further information
1 Click the Select certificates for the users sharing this project 

button from the Project Settings → Security dialog box.
Result: The Certificate Selection dialog box for defining the 
users that should get access to the project opens.

Select certificates for the users sharing 
this project button

2 From the Available certificates in the local Windows 
Certificate Store section, select a certificate with a public 
key.

Icon representing certificates with public 
key:

3 Click the Add certificate from the store below to the 
selection above button.
Result: The selected certificate is added to the Certificates 
for project encryption list of the dialog box.

Add certificate from the store below to the 
selection above button:

NOTE: Add the public keys for all users 
that should have access to the project.

4 To select further certificates in order to provide access to 
this project to several users, repeat steps 2 and 3.

NOTE: The certificates with public key of all users who 
should be allowed to open the project must be installed on 
your local PC.

This step is optional.

5 To confirm your selection, click the OK button.
Result: The certificates that are available in the upper part 
of the Certificate Selection dialog box are added to the open 
project.

–

6 Save the EcoStruxure Machine Expert project to save it with 
encryption.

–

EIO0000004051 12/2019 15



Administration of certificates is required as they have a limited validity and therefore need to be 
updated at regular intervals. Consider this with respect to the life cycle of your machine or control.

Decrypting a Project

How to Decrypt a Project
For decrypting an encrypted EcoStruxure Machine Expert project, proceed as follows:

Assigning Security Levels to the User Profiles
To force encryption or signing options for this user profile, activate the corresponding options from 
the Security level section of this dialog box. For detailed information, refer to the description of the 
Security Screen editor. 

CAUTION
LOSS OF APPLICATION DATA
Store the private key certificate in a safe place and manage the certificates carefully to be able 
to open the protected EcoStruxure Machine Expert project.
Failure to follow these instructions can result in injury or equipment damage.

Step Action
1 Start EcoStruxure Machine Expert.
2 Execute the command View → Security Screen to open the Security Screen editor.
3

In the User tab, click the  button from the Project file decryption area.
Result: The Certificate Selection dialog box is displayed.

4 From the Available certificates in the local Windows Certificate Store section, select the 
certificate with a private key that corresponds to one of the certificates with public key the project 
has been encrypted with. 

5
Click the  button.
Result: The certificate you selected is added to the list of certificates for decrypting project files 
in the upper part of the dialog box.

6 Click OK to confirm.
Result: The Certificate Selection dialog box is closed and the selected certificate is displayed in 
the Project file decryption section of the User tab of the Security Screen editor.
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The information provided in this documentation contains general descriptions and/or technical 
characteristics of the performance of the products contained herein. This documentation is not 
intended as a substitute for and is not to be used for determining suitability or reliability of these 
products for specific user applications. It is the duty of any such user or integrator to perform the 
appropriate and complete risk analysis, evaluation and testing of the products with respect to the 
relevant specific application or use thereof. Neither Schneider Electric nor any of its affiliates or 
subsidiaries shall be responsible or liable for misuse of the information contained herein. If you 
have any suggestions for improvements or amendments or have found errors in this publication, 
please notify us. 
You agree not to reproduce, other than for your own personal, noncommercial use, all or part of 
this document on any medium whatsoever without permission of Schneider Electric, given in 
writing. You also agree not to establish any hypertext links to this document or its content. 
Schneider Electric does not grant any right or license for the personal and noncommercial use of 
the document or its content, except for a non-exclusive license to consult it on an "as is" basis, at 
your own risk. All other rights are reserved.
All pertinent state, regional, and local safety regulations must be observed when installing and 
using this product. For reasons of safety and to help ensure compliance with documented system 
data, only the manufacturer should perform repairs to components.
When devices are used for applications with technical safety requirements, the relevant 
instructions must be followed. 
Failure to use Schneider Electric software or approved software with our hardware products may 
result in injury, harm, or improper operating results.
Failure to observe this information can result in injury or equipment damage.
© 2019 Schneider Electric. All rights reserved.
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Safety Information
Important Information

NOTICE
Read these instructions carefully, and look at the equipment to become familiar with the device 
before trying to install, operate, service, or maintain it. The following special messages may appear 
throughout this documentation or on the equipment to warn of potential hazards or to call attention 
to information that clarifies or simplifies a procedure.
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PLEASE NOTE
Electrical equipment should be installed, operated, serviced, and maintained only by qualified 
personnel. No responsibility is assumed by Schneider Electric for any consequences arising out of 
the use of this material.
A qualified person is one who has skills and knowledge related to the construction and operation 
of electrical equipment and its installation, and has received safety training to recognize and avoid 
the hazards involved.

BEFORE YOU BEGIN
Do not use this product on machinery lacking effective point-of-operation guarding. Lack of 
effective point-of-operation guarding on a machine can result in serious injury to the operator of 
that machine.

This automation equipment and related software is used to control a variety of industrial processes. 
The type or model of automation equipment suitable for each application will vary depending on 
factors such as the control function required, degree of protection required, production methods, 
unusual conditions, government regulations, etc. In some applications, more than one processor 
may be required, as when backup redundancy is needed.
Only you, the user, machine builder or system integrator can be aware of all the conditions and 
factors present during setup, operation, and maintenance of the machine and, therefore, can 
determine the automation equipment and the related safeties and interlocks which can be properly 
used. When selecting automation and control equipment and related software for a particular 
application, you should refer to the applicable local and national standards and regulations. The 
National Safety Council's Accident Prevention Manual (nationally recognized in the United States 
of America) also provides much useful information.
In some applications, such as packaging machinery, additional operator protection such as point-
of-operation guarding must be provided. This is necessary if the operator's hands and other parts 
of the body are free to enter the pinch points or other hazardous areas and serious injury can occur. 
Software products alone cannot protect an operator from injury. For this reason the software 
cannot be substituted for or take the place of point-of-operation protection.
Ensure that appropriate safeties and mechanical/electrical interlocks related to point-of-operation 
protection have been installed and are operational before placing the equipment into service. All 
interlocks and safeties related to point-of-operation protection must be coordinated with the related 
automation equipment and software programming.

WARNING
UNGUARDED EQUIPMENT
 Do not use this software and related automation equipment on equipment which does not have 

point-of-operation protection.
 Do not reach into machinery during operation.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
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NOTE: Coordination of safeties and mechanical/electrical interlocks for point-of-operation 
protection is outside the scope of the Function Block Library, System User Guide, or other 
implementation referenced in this documentation.

START-UP AND TEST
Before using electrical control and automation equipment for regular operation after installation, 
the system should be given a start-up test by qualified personnel to verify correct operation of the 
equipment. It is important that arrangements for such a check be made and that enough time is 
allowed to perform complete and satisfactory testing.

Follow all start-up tests recommended in the equipment documentation. Store all equipment 
documentation for future references.
Software testing must be done in both simulated and real environments.
Verify that the completed system is free from all short circuits and temporary grounds that are not 
installed according to local regulations (according to the National Electrical Code in the U.S.A, for 
instance). If high-potential voltage testing is necessary, follow recommendations in equipment 
documentation to prevent accidental equipment damage.
Before energizing equipment:
 Remove tools, meters, and debris from equipment.
 Close the equipment enclosure door.
 Remove all temporary grounds from incoming power lines.
 Perform all start-up tests recommended by the manufacturer.

WARNING
EQUIPMENT OPERATION HAZARD
 Verify that all installation and set up procedures have been completed.
 Before operational tests are performed, remove all blocks or other temporary holding means 

used for shipment from all component devices.
 Remove tools, meters, and debris from equipment.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
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OPERATION AND ADJUSTMENTS
The following precautions are from the NEMA Standards Publication ICS 7.1-1995 (English 
version prevails):
 Regardless of the care exercised in the design and manufacture of equipment or in the selection 

and ratings of components, there are hazards that can be encountered if such equipment is 
improperly operated.

 It is sometimes possible to misadjust the equipment and thus produce unsatisfactory or unsafe 
operation. Always use the manufacturer’s instructions as a guide for functional adjustments. 
Personnel who have access to these adjustments should be familiar with the equipment 
manufacturer’s instructions and the machinery used with the electrical equipment.

 Only those operational adjustments actually required by the operator should be accessible to 
the operator. Access to other controls should be restricted to prevent unauthorized changes in 
operating characteristics.
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About the Book
At a Glance

Document Scope
This document describes the steps required in EcoStruxure Machine Expert for creating a project 
with a TeSys™ island and a logic/motion controller by using the EtherNet/IP or Modbus TCP 
protocol.
The following knowledge is required:
 Information on functionality, structure, and configuration of the TeSys™ island
 Information on functionality, structure, and configuration of the controller

Validity Note

This document has been updated for the release of EcoStruxureTM Machine Expert V1.1.

Related Documents

Document title Reference

TeSysTM island System Guide www.schneider-electric.us/en/download/;

TeSysTM island DTM Library Online Help www.schneider-electric.us/en/download/;

Modicon M241 Logic Controller Hardware Guide EIO0000001456 (ENG);
EIO0000001457 (FRE);
EIO0000001458 (GER);
EIO0000001459 (SPA);
EIO0000001460 (ITA);
EIO0000001461 (CHS)

Modicon M251 Logic Controller Hardware Guide EIO0000001486 (ENG); 
EIO0000001487 (FRE); 
EIO0000001488 (GER); 
EIO0000001489 (SPA); 
EIO0000001490 (ITA); 
EIO0000001491 (CHS)

Modicon M262 Logic/Motion Controller Hardware 
Guide

EIO0000003659 (ENG); 
EIO0000003660 (FRE); 
EIO0000003661 (GER); 
EIO0000003662 (SPA); 
EIO0000003663 (ITA); 
EIO0000003664 (CHS)
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Product Related Information

1 For additional information, refer to NEMA ICS 1.1 (latest edition), "Safety Guidelines for the 
Application, Installation, and Maintenance of Solid State Control" and to NEMA ICS 7.1 (latest 
edition), "Safety Standards for Construction and Guide for Selection, Installation and Operation of 
Adjustable-Speed Drive Systems" or their equivalent governing your particular location.

EcoStruxure Machine Expert Programming Guide EIO0000002854 (ENG);
EIO0000002855 (FRE);
EIO0000002856 (GER);
EIO0000002858 (SPA);
EIO0000002857 (ITA);
EIO0000002859 (CHS)

Document title Reference

WARNING
LOSS OF CONTROL
 The designer of any control scheme must consider the potential failure modes of control paths 

and, for certain critical control functions, provide a means to achieve a safe state during and 
after a path failure. Examples of critical control functions are emergency stop and overtravel 
stop, power outage and restart.

 Separate or redundant control paths must be provided for critical control functions.
 System control paths may include communication links. Consideration must be given to the 

implications of unanticipated transmission delays or failures of the link.
 Observe all accident prevention regulations and local safety guidelines.1
 Each implementation of this equipment must be individually and thoroughly tested for proper 

operation before being placed into service.
Failure to follow these instructions can result in death, serious injury, or equipment damage.

WARNING
UNINTENDED EQUIPMENT OPERATION
 Only use software approved by Schneider Electric for use with this equipment.
 Update your application program every time you change the physical hardware configuration.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
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Terminology Derived from Standards
The technical terms, terminology, symbols and the corresponding descriptions in this manual, or 
that appear in or on the products themselves, are generally derived from the terms or definitions 
of international standards.
In the area of functional safety systems, drives and general automation, this may include, but is not 
limited to, terms such as safety, safety function, safe state, fault, fault reset, malfunction, failure, 
error, error message, dangerous, etc.
Among others, these standards include:

Standard Description
IEC 61131-2:2007 Programmable controllers, part 2: Equipment requirements and tests.
ISO 13849-1:2015 Safety of machinery: Safety related parts of control systems.

General principles for design.
EN 61496-1:2013 Safety of machinery: Electro-sensitive protective equipment.

Part 1: General requirements and tests.
ISO 12100:2010 Safety of machinery - General principles for design - Risk assessment and risk 

reduction
EN 60204-1:2006 Safety of machinery - Electrical equipment of machines - Part 1: General 

requirements
ISO 14119:2013 Safety of machinery - Interlocking devices associated with guards - Principles 

for design and selection
ISO 13850:2015 Safety of machinery - Emergency stop - Principles for design
IEC 62061:2015 Safety of machinery - Functional safety of safety-related electrical, electronic, 

and electronic programmable control systems
IEC 61508-1:2010 Functional safety of electrical/electronic/programmable electronic safety-

related systems: General requirements.
IEC 61508-2:2010 Functional safety of electrical/electronic/programmable electronic safety-

related systems: Requirements for electrical/electronic/programmable 
electronic safety-related systems.

IEC 61508-3:2010 Functional safety of electrical/electronic/programmable electronic safety-
related systems: Software requirements.

IEC 61784-3:2016 Industrial communication networks - Profiles - Part 3: Functional safety 
fieldbuses - General rules and profile definitions.

2006/42/EC Machinery Directive
2014/30/EU Electromagnetic Compatibility Directive
2014/35/EU Low Voltage Directive
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In addition, terms used in the present document may tangentially be used as they are derived from 
other standards such as:

Finally, the term zone of operation may be used in conjunction with the description of specific 
hazards, and is defined as it is for a hazard zone or danger zone in the Machinery Directive 
(2006/42/EC) and ISO 12100:2010.
NOTE: The aforementioned standards may or may not apply to the specific products cited in the 
present documentation. For more information concerning the individual standards applicable to the 
products described herein, see the characteristics tables for those product references.

Standard Description
IEC 60034 series Rotating electrical machines
IEC 61800 series Adjustable speed electrical power drive systems
IEC 61158 series Digital data communications for measurement and control – Fieldbus for use in 

industrial control systems
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How To Use a TeSys™ island in EcoStruxure Machine Expert

EIO0000003861 06/2019
General Information

Overview
This document describes the steps required in EcoStruxure Machine Expert for creating a project 
with a TeSys™ island and a logic/motion controller by using the EtherNet/IP or Modbus TCP 
protocol.
 Integrating the TeSys™ island into the EcoStruxure Machine Expert project.
 Accessing the TeSys™ island DTM (Device Type Manager) via EcoStruxure Machine Expert 

for configuring the TeSys™ island modules and processes by using avatars.
 Using the function blocks of the TeSys island library that is available in EcoStruxure Machine 

Expert for developing applications and to control avatar modules.

System Requirements
The following components are required for communication via EtherNet/IP or Modbus TCP:

Component Type and Version
Software EcoStruxure Machine Expert V1.1 or later
Controller  TM241CE••• logic controller supporting EtherNet/IP and Modbus 

TCP/IP
 TM251MESE logic controller supporting EtherNet/IP and Modbus 

TCP/IP
 TM262L10/20 logic controller
 TM262M15/25/35 motion controller
EIO0000003861 06/2019 13



Overview of the TeSys™ island Concept
TeSys™ island describes an open, modular distributed input/output system comprising different 
modules residing on a DIN rail backplane:

A Bus coupler
B Analog input / output module
C Digital input / output module
D Voltage interface module
E Standard starter
F SIL (Safety Integrity Level) starter
G SIL interface module
H Power interface module

The entire TeSys™ island acts as a node in a fieldbus network. The bus coupler is the core module 
that provides internal communication with the TeSys™ island modules via ribbon cables and 
external communication via EtherNet/IP or Modbus TCP. For further information, refer to the 
TeSysTM island System Guide.
The integration of this bus coupler as a TeSys™ island communication node in your EcoStruxure 
Machine Expert project is described in the next topic Integrating the TeSys™ island into the 
EcoStruxure Machine Expert Project (see page 15).
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Integrating the TeSys™ island into the EcoStruxure Machine Expert Project

How to Add the TeSys™ island to the EcoStruxure Machine Expert Project
As the bus coupler acts as a single communication node for the complete TeSys™ island, you 
have to add the bus coupler as communication node to your EcoStruxure Machine Expert project.
Proceed as follows:

Step Action Comment
1 Create or open your EcoStruxure Machine Expert 

project.
–

2 Add a controller supporting EtherNet/IP or Modbus 
TCP/IP from the Hardware Catalog → Controller to 
your project.
Result: A controller node is added to the Devices 
tree with several subnodes.

For further information, refer to the chapter Adding 
Devices by Drag and Drop in the Programming 
Guide (see EcoStruxure Machine Expert, 
Programming Guide).

3 From the hardware catalog, select the following 
communication manager, depending on the 
controller you use:
 For M241 or M251 controllers, select Industrial 

Ethernet Manager.
 For M262 controllers, select EtherNet/IP 

Scanner or Modbus TCP IO Scanner depending 
on whether EtherNet/IP or Modbus TCP 
scanner services are required.

Result: The selected communication manager is 
added as a subnode below the Ethernet node in the 
Devices tree.

For further information, refer to the chapter Adding 
Communication Managers in the Programming 
Guide (see EcoStruxure Machine Expert, 
Programming Guide).

4 Right-click the communication manager subnode, 
and execute the command Add Device to add a 
TeSys island element.
Result: A TeSys_island subnode is added below 
the selected communication manager node in the 
Devices tree.

For further information, refer to the chapter Adding 
Devices to a Communication Manager in the 
Programming Guide (see EcoStruxure Machine 
Expert, Programming Guide).
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The figure illustrates the TeSys_island configuration in the Devices tree for M241 and M262 
controllers:
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Configuring the TeSys™ island in EcoStruxure Machine Expert

TeSys™ island Configuration
To configure the TeSys™ island, double-click the TeSys_island node in the Devices tree.
Result: The TeSys_island device editor is displayed in the multi-tabbed editor view of the Logic 
Builder with the default settings and the default device editor tabs (for example, Configuration, 
Parameters, I/O Mapping).
For further information, refer to the chapter Common Device Editor Dialogs in the Programming 
Guide (see EcoStruxure Machine Expert, Programming Guide).

Opening the Configuration Tab
To open the Configuration tab for TeSys™ island configuration, proceed as follows:

Step Action
1 Double-click the TeSys_island node in the Devices tree.

Result: The TeSys_island device editor is displayed in the multi-tabbed editor view of the Logic Builder.
EIO0000003861 06/2019 17



The offline configuration mode is indicated as follows:
 By the blue line in the toolbar and the status Device not connected.
 By the red status Disconnected in the status bar.
You can now configure the TeSys™ island parameters in offline mode using the avatar concept.

2 For initial configuration, click the Start offline button to load the default configuration, and then click the 
Edit configuration... link.
Result: The Configuration tab opens in the TeSys_island device editor, allowing configuration of the 
TeSys™ island in an FDT (Field Device Tool) frame.

Step Action
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Avatar Concept of the TeSys™ island DTM
The TeSys™ island DTM is using an avatar concept. Avatars are functional and digital represen-
tations of the physical modules and processes that are available in the TeSys™ island.
The following types of avatars are available:

For further information, on the avatar concept and the TeSys™ island parameters, refer to the 
TeSys™ island DTM Library Online Help that is provided via context-sensitive help of EcoStruxure 
Machine Expert.

Downloading the Configuration to the TeSys™ island
After you have performed the configuration of the TeSys™ island parameters in offline mode, you 
must download the settings to your TeSys™ island by executing one of the following commands:
 Click the Download button from the Configuration tab of the device editor.
 Right-click the TeSys_island node in the Devices tree, and execute the command Download to 

Device.
Result: A connection to the TeSys™ island is established:
 The status line in the toolbar changes color into orange and indicates Device connected.
 The status bar changes to green and indicates Connected.
This indicates that the configuration settings have successfully been transferred to the TeSys™ 
island.

Using the TeSys island Library for Developing Applications

Overview
The TeSys island library is added to the Library Manager with the integration of the TeSys_island 
element in your EcoStruxure Machine Expert project. It provides function blocks to support you in 
developing applications and to control avatar modules.

Avatar Representing Description
System Bus coupler Managing and integrating the 

TeSys™ island.
Device Individual modules (such as starter, 

input / output modules)
Managing modules as stand-alone 
devices.

Load Module operation relating to a specific 
load

Managing different load type 
applications.
For example, a forward-reverse motor 
avatar includes a forward and reverse 
starter, along with pre-programmed 
forward-reverse operating logic.
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Referencing the TeSys™ island Bus Coupler from the Function Blocks
A reference to the TeSys™ island bus coupler is required by each function block of the TeSys 
island library. To achieve this, configure the name you assigned to the TeSys_Island node in the 
Devices tree as input iq_TeSysIslandRef of the function blocks. 
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Referencing Avatars
The name you assign to each avatar with the parameter Avatar Name in the MY AVATAR tab, 
section AVATAR PARAMETERS of the Configuration tab in the TeSys_island device editor, must 
be referenced in the library with the input i_sAvatarName. 

The name is used to select the avatar to be controlled by the function block. It is available at the 
avatar function blocks, except the asset management function blocks. If the parameter Avatar 
Name is not configured or not correctly configured, the error message AvatarNotAvailable is 
returned. Modifying this name during the execution of the function block will be ignored.
The following figure provides an example of the DigitalIO function block that is only available 
for Digital I/O avatars:
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The following figure provides an example of the Energy function block that is available for all 
avatars, except for the System avatar:
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Referencing Devices
The name you assign to each device of the TeSys™ island with the parameter Name Tag in the 
MY AVATAR tab, section DEVICE PARAMETERS of the Configuration tab in the TeSys_island 
device editor, must be referenced in the library with the input i_sDeviceName.

The name is used to select the device at the function blocks for asset management. If the 
parameter Name Tag is not configured or not correctly configured, the error message DeviceNo-

tAvailable is returned. Modifying this name during the execution of the function block will be 
ignored.
The following figure provides an example of the asset management ProductData function block 
that is available for all devices, except for the bus coupler (system device):
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System Function Blocks Automatically Referencing the Bus Coupler
In contrast to the above described function blocks, the system functions blocks do not require 
references to avatars or devices.
The SystemControl and SystemEnergyBasic function blocks, for example, do not have inputs 
referencing avatars or devices because they are directly linked to the bus coupler (system device):
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The information provided in this documentation contains general descriptions and/or technical 
characteristics of the performance of the products contained herein. This documentation is not 
intended as a substitute for and is not to be used for determining suitability or reliability of these 
products for specific user applications. It is the duty of any such user or integrator to perform the 
appropriate and complete risk analysis, evaluation and testing of the products with respect to the 
relevant specific application or use thereof. Neither Schneider Electric nor any of its affiliates or 
subsidiaries shall be responsible or liable for misuse of the information contained herein. If you 
have any suggestions for improvements or amendments or have found errors in this publication, 
please notify us. 
You agree not to reproduce, other than for your own personal, noncommercial use, all or part of 
this document on any medium whatsoever without permission of Schneider Electric, given in 
writing. You also agree not to establish any hypertext links to this document or its content. 
Schneider Electric does not grant any right or license for the personal and noncommercial use of 
the document or its content, except for a non-exclusive license to consult it on an "as is" basis, at 
your own risk. All other rights are reserved.
All pertinent state, regional, and local safety regulations must be observed when installing and 
using this product. For reasons of safety and to help ensure compliance with documented system 
data, only the manufacturer should perform repairs to components.
When devices are used for applications with technical safety requirements, the relevant 
instructions must be followed. 
Failure to use Schneider Electric software or approved software with our hardware products may 
result in injury, harm, or improper operating results.
Failure to observe this information can result in injury or equipment damage.
© 2019 Schneider Electric. All rights reserved.
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Safety Information
Important Information

NOTICE
Read these instructions carefully, and look at the equipment to become familiar with the device 
before trying to install, operate, service, or maintain it. The following special messages may appear 
throughout this documentation or on the equipment to warn of potential hazards or to call attention 
to information that clarifies or simplifies a procedure.
EIO0000003891 12/2019 5



PLEASE NOTE
Electrical equipment should be installed, operated, serviced, and maintained only by qualified 
personnel. No responsibility is assumed by Schneider Electric for any consequences arising out of 
the use of this material.
A qualified person is one who has skills and knowledge related to the construction and operation 
of electrical equipment and its installation, and has received safety training to recognize and avoid 
the hazards involved.

BEFORE YOU BEGIN
Do not use this product on machinery lacking effective point-of-operation guarding. Lack of 
effective point-of-operation guarding on a machine can result in serious injury to the operator of 
that machine.

This automation equipment and related software is used to control a variety of industrial processes. 
The type or model of automation equipment suitable for each application will vary depending on 
factors such as the control function required, degree of protection required, production methods, 
unusual conditions, government regulations, etc. In some applications, more than one processor 
may be required, as when backup redundancy is needed.
Only you, the user, machine builder or system integrator can be aware of all the conditions and 
factors present during setup, operation, and maintenance of the machine and, therefore, can 
determine the automation equipment and the related safeties and interlocks which can be properly 
used. When selecting automation and control equipment and related software for a particular 
application, you should refer to the applicable local and national standards and regulations. The 
National Safety Council's Accident Prevention Manual (nationally recognized in the United States 
of America) also provides much useful information.
In some applications, such as packaging machinery, additional operator protection such as point-
of-operation guarding must be provided. This is necessary if the operator's hands and other parts 
of the body are free to enter the pinch points or other hazardous areas and serious injury can occur. 
Software products alone cannot protect an operator from injury. For this reason the software 
cannot be substituted for or take the place of point-of-operation protection.
Ensure that appropriate safeties and mechanical/electrical interlocks related to point-of-operation 
protection have been installed and are operational before placing the equipment into service. All 
interlocks and safeties related to point-of-operation protection must be coordinated with the related 
automation equipment and software programming.

WARNING
UNGUARDED EQUIPMENT
 Do not use this software and related automation equipment on equipment which does not have 

point-of-operation protection.
 Do not reach into machinery during operation.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
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NOTE: Coordination of safeties and mechanical/electrical interlocks for point-of-operation 
protection is outside the scope of the Function Block Library, System User Guide, or other 
implementation referenced in this documentation.

START-UP AND TEST
Before using electrical control and automation equipment for regular operation after installation, 
the system should be given a start-up test by qualified personnel to verify correct operation of the 
equipment. It is important that arrangements for such a check be made and that enough time is 
allowed to perform complete and satisfactory testing.

Follow all start-up tests recommended in the equipment documentation. Store all equipment 
documentation for future references.
Software testing must be done in both simulated and real environments.
Verify that the completed system is free from all short circuits and temporary grounds that are not 
installed according to local regulations (according to the National Electrical Code in the U.S.A, for 
instance). If high-potential voltage testing is necessary, follow recommendations in equipment 
documentation to prevent accidental equipment damage.
Before energizing equipment:
 Remove tools, meters, and debris from equipment.
 Close the equipment enclosure door.
 Remove all temporary grounds from incoming power lines.
 Perform all start-up tests recommended by the manufacturer.

WARNING
EQUIPMENT OPERATION HAZARD
 Verify that all installation and set up procedures have been completed.
 Before operational tests are performed, remove all blocks or other temporary holding means 

used for shipment from all component devices.
 Remove tools, meters, and debris from equipment.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
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OPERATION AND ADJUSTMENTS
The following precautions are from the NEMA Standards Publication ICS 7.1-1995 (English 
version prevails):
 Regardless of the care exercised in the design and manufacture of equipment or in the selection 

and ratings of components, there are hazards that can be encountered if such equipment is 
improperly operated.

 It is sometimes possible to misadjust the equipment and thus produce unsatisfactory or unsafe 
operation. Always use the manufacturer’s instructions as a guide for functional adjustments. 
Personnel who have access to these adjustments should be familiar with the equipment 
manufacturer’s instructions and the machinery used with the electrical equipment.

 Only those operational adjustments actually required by the operator should be accessible to 
the operator. Access to other controls should be restricted to prevent unauthorized changes in 
operating characteristics.
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About the Book
At a Glance

Document Scope
This document describes the steps required in the different software programs for exchanging data 
between the tools by using system projects. It is assumed that you have thorough knowledge of 
the software program you are using. The present document concentrates on listing the required 
steps and does not provide further information.

Validity Note

This document has been updated for the release of EcoStruxureTM Machine Expert V1.2.

Related Documents

Document title Reference
EcoStruxure Machine Expert Programming Guide EIO0000002854 (ENG);

EIO0000002855 (FRE);
EIO0000002856 (GER);
EIO0000002858 (SPA);
EIO0000002857 (ITA);
EIO0000002859 (CHS)

Motion Sizer Online Help EIO0000002157 (ENG);
EIO0000002158 (FRE);
EIO0000002159 (GER);
EIO0000002161 (SPA);
EIO0000002160 (ITA);
EIO0000002162 (CHS);
EIO0000002163 (TUR);
EIO0000002164 (POR);
EIO0000002165 (RUS)
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Product Related Information

1 For additional information, refer to NEMA ICS 1.1 (latest edition), "Safety Guidelines for the 
Application, Installation, and Maintenance of Solid State Control" and to NEMA ICS 7.1 (latest 
edition), "Safety Standards for Construction and Guide for Selection, Installation and Operation of 
Adjustable-Speed Drive Systems" or their equivalent governing your particular location.

Terminology Derived from Standards
The technical terms, terminology, symbols and the corresponding descriptions in this manual, or 
that appear in or on the products themselves, are generally derived from the terms or definitions 
of international standards.
In the area of functional safety systems, drives and general automation, this may include, but is not 
limited to, terms such as safety, safety function, safe state, fault, fault reset, malfunction, failure, 
error, error message, dangerous, etc.
Among others, these standards include:

WARNING
LOSS OF CONTROL
 The designer of any control scheme must consider the potential failure modes of control paths 

and, for certain critical control functions, provide a means to achieve a safe state during and 
after a path failure. Examples of critical control functions are emergency stop and overtravel 
stop, power outage and restart.

 Separate or redundant control paths must be provided for critical control functions.
 System control paths may include communication links. Consideration must be given to the 

implications of unanticipated transmission delays or failures of the link.
 Observe all accident prevention regulations and local safety guidelines.1
 Each implementation of this equipment must be individually and thoroughly tested for proper 

operation before being placed into service.
Failure to follow these instructions can result in death, serious injury, or equipment damage.

WARNING
UNINTENDED EQUIPMENT OPERATION
 Only use software approved by Schneider Electric for use with this equipment.
 Update your application program every time you change the physical hardware configuration.
Failure to follow these instructions can result in death, serious injury, or equipment damage.

Standard Description
IEC 61131-2:2007 Programmable controllers, part 2: Equipment requirements and tests.
10 EIO0000003891 12/2019



In addition, terms used in the present document may tangentially be used as they are derived from 
other standards such as:

Finally, the term zone of operation may be used in conjunction with the description of specific 
hazards, and is defined as it is for a hazard zone or danger zone in the Machinery Directive 
(2006/42/EC) and ISO 12100:2010.
NOTE: The aforementioned standards may or may not apply to the specific products cited in the 
present documentation. For more information concerning the individual standards applicable to the 
products described herein, see the characteristics tables for those product references.

ISO 13849-1:2015 Safety of machinery: Safety related parts of control systems.
General principles for design.

EN 61496-1:2013 Safety of machinery: Electro-sensitive protective equipment.
Part 1: General requirements and tests.

ISO 12100:2010 Safety of machinery - General principles for design - Risk assessment and risk reduction
EN 60204-1:2006 Safety of machinery - Electrical equipment of machines - Part 1: General requirements
ISO 14119:2013 Safety of machinery - Interlocking devices associated with guards - Principles for design and 

selection
ISO 13850:2015 Safety of machinery - Emergency stop - Principles for design
IEC 62061:2015 Safety of machinery - Functional safety of safety-related electrical, electronic, and electronic 

programmable control systems
IEC 61508-1:2010 Functional safety of electrical/electronic/programmable electronic safety-related systems: 

General requirements.
IEC 61508-2:2010 Functional safety of electrical/electronic/programmable electronic safety-related systems: 

Requirements for electrical/electronic/programmable electronic safety-related systems.
IEC 61508-3:2010 Functional safety of electrical/electronic/programmable electronic safety-related systems: 

Software requirements.
IEC 61784-3:2016 Industrial communication networks - Profiles - Part 3: Functional safety fieldbuses - General 

rules and profile definitions.
2006/42/EC Machinery Directive
2014/30/EU Electromagnetic Compatibility Directive
2014/35/EU Low Voltage Directive

Standard Description

Standard Description
IEC 60034 series Rotating electrical machines
IEC 61800 series Adjustable speed electrical power drive systems
IEC 61158 series Digital data communications for measurement and control – Fieldbus for use in 

industrial control systems
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How To Exchange Data Between Tools

EIO0000003891 12/2019
General Information

Overview
This document lists the steps required in the different software programs for exchanging data by 
using system projects.
A system project can contain one or more application projects that are intended to be edited by 
different users or from different software programs. Beyond project-specific data, the application 
projects that are part of system projects contain system data that can be shared in different 
software programs, as for example, cam diagrams that were created with Motion Sizer can be 
edited in EcoStruxure Machine Expert Logic Builder. 
System projects must be saved in a central repository. This is a user-definable local or network 
folder that must be made available to all users that should have access to a system project. The 
users that have access to this folder can consecutively open and edit the project locally. While an 
application project is being edited by a user, it is locked for other users. An application project can 
only be edited by one user at a time.
For further information on handling system projects in EcoStruxure Machine Expert Logic Builder, 
refer to the Menu Commands online help.

System Requirements
The software programs that are used for editing system projects must meet the following 
requirements:

Software program Version 
Motion Sizer V4.1 or later installed via the Machine Expert Installer
EcoStruxure Operator Terminal Expert V3.1 SP1 or later installed via the Machine Expert Installer
EcoStruxure Machine Expert Logic Builder EcoStruxure Machine Expert V1.1 or later with the following additional 

components installed via the Machine Expert Installer:
 Tools → Tool2Tool
 MachineExpert Components → LogicBuilder → ToolCollaboration
EIO0000003891 12/2019  EcoStruxure Machine Expert version 1.2 does not support EcoStruxure Operator Terminal Expert. 13



Steps to be Performed in Motion Sizer

Optional Preparatory Step: Creating and Configuring a Working Directory
You can create your own working directory. This is a folder where system projects are saved on 
your local PC when they are opened for editing. If you do not configure your own working directory 
as described in the following steps, the default directory is used by Motion Sizer.
Proceed as follows:

Prerequisite: Creating a System Location Folder for Saving System Projects
Create a system location folder that is a folder that acts as system repository where system 
projects are saved to allow access by different users or from different software programs:
 In order to work individually on a system project and to open it in different software programs, 

such as EcoStruxure Machine Expert Logic Builder or Motion Sizer, you can create a folder on 
your local PC.
Example: Local disk C:\Exchange_local

Creating a New System Project for Sharing a Cam Diagram
To create a new Motion Sizer project as part of a system project, perform the following steps:

Step Action
1 By using the Windows Explorer, create an empty folder on the local disk of your PC.

Example: Local disk C:\Work\MotionSizer.
2 Start Motion Sizer.
3 Make sure that no system project is open.
4 Click the Options button from the toolbar.

Result: The User preferences dialog box opens.
5 In the User preferences dialog box, select the ToolCollaboration view.
6 In the ToolCollaboration view, paste the path to the local folder you created to the Working Copy 

Base Path field, or click the folder button to navigate to the folder.
Example: C:\Work\MotionSizer.

7 Click Apply to confirm the selected folder.
8 Click OK to close the dialog box.

Step Action
1 In Motion Sizer, click the Open System Explorer button from the toolbar.

Result: The System Explorer dialog box opens.
2 Enter the path to the system location folder in the System Location box.

Example as created in step Prerequisite (see page 14): C:\Exchange_local)
3 Click the Create System Project button.
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Linking a Cam Diagram to an EcoStruxure Machine Expert Logic Builder Project
You can link your cam diagram in Motion Sizer directly to a cam diagram in EcoStruxure Machine 
Expert Logic Builder in order to retrieve updates that have been performed on the cam diagram in 
Logic Builder and have been saved to the system project:

To refresh the view of the cam diagram in Motion Sizer with the updates made in EcoStruxure 
Machine Expert Logic Builder, right-click the CamDiagram node in the Motion Sizer Project 
Explorer and execute the command Update from system. The modifications made in EcoStruxure 
Machine Expert Logic Builder are applied to the axis in the cam diagram in Motion Sizer.

4 In the Create System part of the System Explorer dialog box, enter the System Name, for 
example, System1 and the optional System Description, and click the Create button. 
Result: The new system project System1 is added to the list of SYSTEM PROJECTS on the 
left-hand side of the System Explorer dialog box.

5 Click the Add Current Project button.
Results:
 The open Motion Sizer project is added to the system project System1.
 The System Explorer dialog box closes.

6 In the Motion Sizer Project Explorer, right-click an Axis node, and execute the Add CAM 
diagram command.
Result: A CamDiagram node is added below the Axis node.

7 Configure the movement of your axis in the cam diagram according to your individual 
requirements.

8 Click the Save button from the toolbar to save the Motion Sizer project to the local working 
directory.

9 Click the Save to Repository button from the toolbar to save the Motion Sizer project as part of 
the system project System1 to the system location folder.
Result: The cam diagram has been published to the system repository and is therefore available 
for use in other software programs as for example, the EcoStruxure Machine Expert Logic 
Builder.

Step Action

Step Action Comment
1 Right-click the CamDiagram node in the Motion Sizer 

Project Explorer and execute the command Bind with 
system CamDiagram entry.
Result: A dialog box is displayed indicating the list of 
cam diagram entries in the system.

–

2 Select the suitable Logic Builder project from the list 
and click the Link button.
Result: The cam diagram in Motion Sizer is linked to 
the cam diagram in Logic Builder and the values in 
Motion Sizer are updated.

This step is only required if several Logic 
Builder projects are available as system 
projects. 
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Steps to be Performed in EcoStruxure Operator Terminal Expert

Prerequisite: Creating a System Location Folder for Saving System Projects
Create a system location folder that is a folder that acts as system repository where system 
projects are saved to allow access by different users or from different software programs.
Example: Local disk C:\Exchange_local

Creating a New System Project for Sharing Symbols
To create a new EcoStruxure Operator Terminal Expert project as part of a system project, 
perform the following steps:

Step Action
1 Start EcoStruxure Operator Terminal Expert.
2 Open the project that you want to add to a system project.
3 Click the Show System Explorer button from the toolbar.

Result: The System Explorer dialog box opens.
4 Enter the path to the system location folder (see page 16) in the System Location box.
5 Click the Create System Project button.
6 In the Create System part of the System Explorer dialog box, enter the System Name, for 

example, System1 and the optional System Description, and click the Create button. 
Result: The new system project System1 is added to the list of SYSTEM PROJECTS on the 
left-hand side of the System Explorer dialog box.

7 Click the Add Current Project button.
Results:
 The open EcoStruxure Operator Terminal Expert project is added to the system project 

System1.
 The System Explorer dialog box closes.
 The System Mode icon is displayed in the upper right corner of the 

EcoStruxure Operator Terminal Expert dialog box to indicate that a system project is open.
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Configuring a Target Controller of an EcoStruxure Machine Expert Logic Builder Project
Configure the controller of an EcoStruxure Machine Expert project from which you want to retrieve 
the symbol configuration:

Importing a Symbol Configuration of an EcoStruxure Machine Expert Logic Builder Project
You can link the symbol configuration of the configured controller directly to your 
EcoStruxure Operator Terminal Expert project in order to retrieve updates that have been 
performed in Logic Builder and have been saved to the system project:

Step Action
1 In the Project Explorer tree, select the System Architecture → Target → Driver node and click 

the +Driver button.
Result: The Add Driver dialog box is displayed. 

2 From the list Manufacturer, select Schneider Electric.
From the list Driver, select SoMachine Network.
Click the OK button.
Result: A Schneider Electric SoMachine Network node is created below the Driver node.

3 In the System Architecture view in the middle of the EcoStruxure Operator Terminal Expert 
screen, click the +Equipment button.
Result: A SoMachineNetworkEquipment entry is added to the Equipment list.

4 Select the SoMachineNetworkEquipment entry and configure the Properties on the right-hand 
side of the EcoStruxure Operator Terminal Expert screen.

5 Select the SoMachineNetworkEquipment entry (column Name) and rename it by using the 
controller name.

NOTE: Since this name is used as prefix for the symbols that will be imported from the 
EcoStruxure Machine Expert symbol configuration, enter a meaningful and unique name.

6 To define the controller, retrieve the exact node name or IP address from the Communication 
Settings tab (see EcoStruxure Machine Expert, Programming Guide) in EcoStruxure Machine 
Expert Logic Builder, enter this information in the NodeName or IP Address text box in the Basic 
tab of the Properties.

Step Action
1 In the Project Explorer tree, select the Variables → Symbol Link node and click the +Symbol 

button.
2 From the Equipment Name list, select the entry of the Schneider Electric controller you defined.

From the Format List, select SoMachine Symbol File.
Click the Import button.
Result: The Device Selector dialog box is displayed.

3 From the Device Selector dialog box, select a controller entry and click OK.
Result: The variables of the selected controller are imported and displayed in the Variables view 
in the middle of the EcoStruxure Operator Terminal Expert screen. You can use them in the 
EcoStruxure Operator Terminal Expert screens.
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Refreshing a Symbol Configuration after Modifying an EcoStruxure Machine Expert Logic Builder Project
After the symbol configuration of the system project has been modified in Logic Builder, perform 
the following steps to retrieve the updated variables:

Steps to be Performed in EcoStruxure Machine Expert Logic Builder

Optional Preparatory Step: Creating and Configuring a Working Directory
You can create your own working directory. This is a folder where system projects are saved on 
your local PC when they are opened for editing. If you do not configure your own working directory 
as described in the following steps, the default directory is used by EcoStruxure Machine Expert 
Logic Builder.
Proceed as follows:

Step Action
1 In the Project Explorer tree, select the controller node below Variables → Symbol Link whose 

variables you want to refresh.
2 Click the Delete button from the toolbar and confirm the Confirmation message with Yes.

NOTE: Variables configured in the EcoStruxure Operator Terminal Expert screens will still be 
available after deleting the variable list.
Result: The selected controller node is removed from the Project Explorer tree.

3 Proceed by executing the steps described for Importing a Symbol Configuration of an 
EcoStruxure Machine Expert Logic Builder Project (see page 17).

Step Action
1 By using the Windows Explorer, create an empty folder on the local disk of your PC.

Example: Local disk C:\Work\LogicBuilder.
2 Start EcoStruxure Machine Expert Logic Builder.
3 Make sure that no system project is open.
4 Open the Tools → Options → System Project dialog box.
5 Paste the path to the local folder you created to the Working Copy Base Path field, or click the 

browse (...) button to navigate to the folder.
Example: C:\Work\LogicBuilder.

6 Click OK to confirm and to close the dialog box.
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Creating a New EcoStruxure Machine Expert Project that is Part of a System Project
To create a new EcoStruxure Machine Expert project as part of a system project, perform the 
following steps:

Editing a Cam Diagram via System Project
To edit the cam diagram that has been saved in a Motion Sizer project that is part of the open 
system project System1, proceed as follows:

In order to retrieve updates that have been performed on the cam diagram via Motion Sizer and 
have been saved to the system project, right-click the CamDiagram node in the Tools tree, and 
execute the command Update from System.
Result: The modifications made in Motion Sizer are applied to the cam motion editor in 
EcoStruxure Machine Expert Logic Builder.
For the steps to be performed in Motion Sizer, refer to the Motion Sizer chapter (see page 14). 

Step Action
1 Execute the File → New Project command.
2 In the New Project dialog box, configure the parameters for creating a new Default Project.
3 In the Select project file location section, select the option Create as part of System Project.
4 Enter the path to the system location folder in the System Location box, or click the browse 

button (...) to open the System Explorer dialog box.
Example as created in step Prerequisite for Motion Sizer (see page 14): C:\Exchange_local)

5 Select the system project System1 from the list of SYSTEM PROJECTS on the left-hand side 
of the System Explorer dialog box.

6 Click the Select button to close the System Explorer dialog box and to return to the New Project 
dialog box.
Result: The New Project dialog box contains the following values:
 System Location = C:\Exchange_local
 System Project Name = System1

7 Click OK to close the New Project dialog box and to create the new EcoStruxure Machine Expert 
project as part of a system project.
Result: EcoStruxure Machine Expert Logic Builder opens the project you have defined.

Step Action
1 In the Tools tree, right-click the Application node and execute the command Add Object → 

System Import: CamDiagram....
Result: The Add System Import: CamDiagram dialog box opens and displays the cam diagrams 
available in the system project. 

2 Select the cam diagram from the list, and click the Add button.
Result: A CamDiagram node is added below the Application node in the Tools tree, and the cam 
motion editor opens, displaying the cam diagram that has been created in Motion Sizer.
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Sharing the Symbol Configuration with EcoStruxure Operator Terminal Expert via System Project
To provide the variables declared in the EcoStruxure Machine Expert Logic Builder Symbol 
Configuration (see EcoStruxure Machine Expert, Programming Guide) to 
EcoStruxure Operator Terminal Expert, proceed as follows:

For the steps to be performed in EcoStruxure Operator Terminal Expert, refer to the 
EcoStruxure Operator Terminal Expert chapter (see page 16). 

Step Action
1 In the Symbol Configuration editor, configure the variables you want to share with 

EcoStruxure Operator Terminal Expert and save the project as part of a system project.
2 Publish this symbol configuration by executing the command System Project → Save to 

Repository or by opening the System Explorer, right-clicking the system project, and executing 
the command Publish Changes.
Result: The variables saved in the symbol configuration are available for import (see page 17) 
into EcoStruxure Operator Terminal Expert via the System Explorer.
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The information provided in this documentation contains general descriptions and/or technical 
characteristics of the performance of the products contained herein. This documentation is not 
intended as a substitute for and is not to be used for determining suitability or reliability of these 
products for specific user applications. It is the duty of any such user or integrator to perform the 
appropriate and complete risk analysis, evaluation and testing of the products with respect to the 
relevant specific application or use thereof. Neither Schneider Electric nor any of its affiliates or 
subsidiaries shall be responsible or liable for misuse of the information contained herein. If you 
have any suggestions for improvements or amendments or have found errors in this publication, 
please notify us. 
You agree not to reproduce, other than for your own personal, noncommercial use, all or part of 
this document on any medium whatsoever without permission of Schneider Electric, given in 
writing. You also agree not to establish any hypertext links to this document or its content. 
Schneider Electric does not grant any right or license for the personal and noncommercial use of 
the document or its content, except for a non-exclusive license to consult it on an "as is" basis, at 
your own risk. All other rights are reserved.
All pertinent state, regional, and local safety regulations must be observed when installing and 
using this product. For reasons of safety and to help ensure compliance with documented system 
data, only the manufacturer should perform repairs to components.
When devices are used for applications with technical safety requirements, the relevant 
instructions must be followed. 
Failure to use Schneider Electric software or approved software with our hardware products may 
result in injury, harm, or improper operating results.
Failure to observe this information can result in injury or equipment damage.
© 2019 Schneider Electric. All rights reserved.
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Safety Information
Important Information

NOTICE
Read these instructions carefully, and look at the equipment to become familiar with the device 
before trying to install, operate, service, or maintain it. The following special messages may appear 
throughout this documentation or on the equipment to warn of potential hazards or to call attention 
to information that clarifies or simplifies a procedure.
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PLEASE NOTE
Electrical equipment should be installed, operated, serviced, and maintained only by qualified 
personnel. No responsibility is assumed by Schneider Electric for any consequences arising out of 
the use of this material.
A qualified person is one who has skills and knowledge related to the construction and operation 
of electrical equipment and its installation, and has received safety training to recognize and avoid 
the hazards involved.

BEFORE YOU BEGIN
Do not use this product on machinery lacking effective point-of-operation guarding. Lack of 
effective point-of-operation guarding on a machine can result in serious injury to the operator of 
that machine.

This automation equipment and related software is used to control a variety of industrial processes. 
The type or model of automation equipment suitable for each application will vary depending on 
factors such as the control function required, degree of protection required, production methods, 
unusual conditions, government regulations, etc. In some applications, more than one processor 
may be required, as when backup redundancy is needed.
Only you, the user, machine builder or system integrator can be aware of all the conditions and 
factors present during setup, operation, and maintenance of the machine and, therefore, can 
determine the automation equipment and the related safeties and interlocks which can be properly 
used. When selecting automation and control equipment and related software for a particular 
application, you should refer to the applicable local and national standards and regulations. The 
National Safety Council's Accident Prevention Manual (nationally recognized in the United States 
of America) also provides much useful information.
In some applications, such as packaging machinery, additional operator protection such as point-
of-operation guarding must be provided. This is necessary if the operator's hands and other parts 
of the body are free to enter the pinch points or other hazardous areas and serious injury can occur. 
Software products alone cannot protect an operator from injury. For this reason the software 
cannot be substituted for or take the place of point-of-operation protection.
Ensure that appropriate safeties and mechanical/electrical interlocks related to point-of-operation 
protection have been installed and are operational before placing the equipment into service. All 
interlocks and safeties related to point-of-operation protection must be coordinated with the related 
automation equipment and software programming.

WARNING
UNGUARDED EQUIPMENT
 Do not use this software and related automation equipment on equipment which does not have 

point-of-operation protection.
 Do not reach into machinery during operation.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
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NOTE: Coordination of safeties and mechanical/electrical interlocks for point-of-operation 
protection is outside the scope of the Function Block Library, System User Guide, or other 
implementation referenced in this documentation.

START-UP AND TEST
Before using electrical control and automation equipment for regular operation after installation, 
the system should be given a start-up test by qualified personnel to verify correct operation of the 
equipment. It is important that arrangements for such a check be made and that enough time is 
allowed to perform complete and satisfactory testing.

Follow all start-up tests recommended in the equipment documentation. Store all equipment 
documentation for future references.
Software testing must be done in both simulated and real environments.
Verify that the completed system is free from all short circuits and temporary grounds that are not 
installed according to local regulations (according to the National Electrical Code in the U.S.A, for 
instance). If high-potential voltage testing is necessary, follow recommendations in equipment 
documentation to prevent accidental equipment damage.
Before energizing equipment:
 Remove tools, meters, and debris from equipment.
 Close the equipment enclosure door.
 Remove all temporary grounds from incoming power lines.
 Perform all start-up tests recommended by the manufacturer.

WARNING
EQUIPMENT OPERATION HAZARD
 Verify that all installation and set up procedures have been completed.
 Before operational tests are performed, remove all blocks or other temporary holding means 

used for shipment from all component devices.
 Remove tools, meters, and debris from equipment.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
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OPERATION AND ADJUSTMENTS
The following precautions are from the NEMA Standards Publication ICS 7.1-1995 (English 
version prevails):
 Regardless of the care exercised in the design and manufacture of equipment or in the selection 

and ratings of components, there are hazards that can be encountered if such equipment is 
improperly operated.

 It is sometimes possible to misadjust the equipment and thus produce unsatisfactory or unsafe 
operation. Always use the manufacturer’s instructions as a guide for functional adjustments. 
Personnel who have access to these adjustments should be familiar with the equipment 
manufacturer’s instructions and the machinery used with the electrical equipment.

 Only those operational adjustments actually required by the operator should be accessible to 
the operator. Access to other controls should be restricted to prevent unauthorized changes in 
operating characteristics.
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About the Book
At a Glance

Document Scope
This document describes the steps for managing certificates which should be used for secured 
TCP communication at application level.

Validity Note

This document has been updated for the release of EcoStruxureTM Machine Expert V1.1.

Related Documents

Document title Reference
Modicon M262 Logic/Motion Controller Hardware 
Guide

EIO0000003659 (ENG); 
EIO0000003660 (FRE); 
EIO0000003661 (GER); 
EIO0000003662 (SPA); 
EIO0000003663 (ITA); 
EIO0000003664 (CHS)

EcoStruxure Machine Expert Programming Guide EIO0000002854 (ENG);
EIO0000002855 (FRE);
EIO0000002856 (GER);
EIO0000002858 (SPA);
EIO0000002857 (ITA);
EIO0000002859 (CHS)
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Product Related Information

1 For additional information, refer to NEMA ICS 1.1 (latest edition), "Safety Guidelines for the 
Application, Installation, and Maintenance of Solid State Control" and to NEMA ICS 7.1 (latest 
edition), "Safety Standards for Construction and Guide for Selection, Installation and Operation of 
Adjustable-Speed Drive Systems" or their equivalent governing your particular location.

WARNING
LOSS OF CONTROL
 The designer of any control scheme must consider the potential failure modes of control paths 

and, for certain critical control functions, provide a means to achieve a safe state during and 
after a path failure. Examples of critical control functions are emergency stop and overtravel 
stop, power outage and restart.

 Separate or redundant control paths must be provided for critical control functions.
 System control paths may include communication links. Consideration must be given to the 

implications of unanticipated transmission delays or failures of the link.
 Observe all accident prevention regulations and local safety guidelines.1
 Each implementation of this equipment must be individually and thoroughly tested for proper 

operation before being placed into service.
Failure to follow these instructions can result in death, serious injury, or equipment damage.

WARNING
UNINTENDED EQUIPMENT OPERATION
 Only use software approved by Schneider Electric for use with this equipment.
 Update your application program every time you change the physical hardware configuration.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
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Terminology Derived from Standards
The technical terms, terminology, symbols and the corresponding descriptions in this manual, or 
that appear in or on the products themselves, are generally derived from the terms or definitions 
of international standards.
In the area of functional safety systems, drives and general automation, this may include, but is not 
limited to, terms such as safety, safety function, safe state, fault, fault reset, malfunction, failure, 
error, error message, dangerous, etc.
Among others, these standards include:

Standard Description
IEC 61131-2:2007 Programmable controllers, part 2: Equipment requirements and tests.
ISO 13849-1:2015 Safety of machinery: Safety related parts of control systems.

General principles for design.
EN 61496-1:2013 Safety of machinery: Electro-sensitive protective equipment.

Part 1: General requirements and tests.
ISO 12100:2010 Safety of machinery - General principles for design - Risk assessment and risk 

reduction
EN 60204-1:2006 Safety of machinery - Electrical equipment of machines - Part 1: General 

requirements
ISO 14119:2013 Safety of machinery - Interlocking devices associated with guards - Principles 

for design and selection
ISO 13850:2015 Safety of machinery - Emergency stop - Principles for design
IEC 62061:2015 Safety of machinery - Functional safety of safety-related electrical, electronic, 

and electronic programmable control systems
IEC 61508-1:2010 Functional safety of electrical/electronic/programmable electronic safety-

related systems: General requirements.
IEC 61508-2:2010 Functional safety of electrical/electronic/programmable electronic safety-

related systems: Requirements for electrical/electronic/programmable 
electronic safety-related systems.

IEC 61508-3:2010 Functional safety of electrical/electronic/programmable electronic safety-
related systems: Software requirements.

IEC 61784-3:2016 Industrial communication networks - Profiles - Part 3: Functional safety 
fieldbuses - General rules and profile definitions.

2006/42/EC Machinery Directive
2014/30/EU Electromagnetic Compatibility Directive
2014/35/EU Low Voltage Directive
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In addition, terms used in the present document may tangentially be used as they are derived from 
other standards such as:

Finally, the term zone of operation may be used in conjunction with the description of specific 
hazards, and is defined as it is for a hazard zone or danger zone in the Machinery Directive 
(2006/42/EC) and ISO 12100:2010.
NOTE: The aforementioned standards may or may not apply to the specific products cited in the 
present documentation. For more information concerning the individual standards applicable to the 
products described herein, see the characteristics tables for those product references.

Standard Description
IEC 60034 series Rotating electrical machines
IEC 61800 series Adjustable speed electrical power drive systems
IEC 61158 series Digital data communications for measurement and control – Fieldbus for use in 

industrial control systems
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Applications Implementing Secured TCP Communication

Communication Libraries
EcoStruxure Machine Expert provides libraries that support secured communication using TLS 
(Transport Layer Security). They provide client and/or server functionality as indicated in the 
following table:

The clients or server can be configured to use TLS for encrypted communication.
Whether a connection using TLS is supported depends on the controller where the corresponding 
function block is used. Refer to the specific manual of your controller to verify if TCP 
communication using TLS is supported.

Certificates
In the context of TLS, certificates can be used to verify the identity of the communication partners. 
Certificates are sent during the establishing of a connection, the so-called TLS handshake. The 
sending of the certificate is optional for the client, unless the server requests the client certificate. 
The server is sending its certificate at every time. Only if the result of the verification of the 
certificate is positive a connection with the communication partner can be established.

Verification of Certificates
The EcoStruxure Machine Expert libraries that support secured connection using TLS provide the 
parameter etCertVerifyMode for selecting the mode of verification of the certificate which is 
sent by the communication partner during the TLS handshake.
The following modes are supported:

Library Providing the functionality of:
TcpUdpCommunication  TCP client

 TCP server

HttpHandling HTTP/HTTPS client
MqttHandling MQTT / secured MQTT client
EmailHandling  SMTP/SMTPS client

 POP3/POP3S client

etCertVerifyMode Mode Description
TrustedOnly A certificate from the communication partner is required.

The certificate must be classified as trusted.
AllCertificates A certificate from the communication partner is required.

Further verification on the certificate is not performed.
NotVerified No certificate from the communication partner is required.
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If the client or server is configured to verify the server certificate in mode TrustedOnly, it is 
required to manage the certificates on your controller in a manual manner. This can be performed 
using the editor Security Screen in EcoStruxure Machine Expert Logic Builder. The required steps 
are described in the following section.
NOTE: TrustedOnly is the only way to authenticate the communication partner.

Managing Certificates on the Controller

Overview
If the client or server is configured to verify the certificate of the communication partner in mode 
TrustedOnly, the corresponding certificate must be available on the controller and it must be 
declared as trusted. To achieve this, use the editor Security Screen in EcoStruxure Machine Expert 
Logic Builder to manage the certificates on your controller.

Security Screen Editor
The Security Screen editor is available in EcoStruxure Machine Expert Logic Builder via the View 
→ Security Screen command. The Devices tab of the Security Screen editor provides access to 
the folders that are dedicated to managing certificates on the connected controller. 

Click the  button to display the corresponding folders and their content for the certificate 
handling on the connected controller.
For example, the following categories are available for the Modicon M262 Logic/Motion Controller:
 Own Certificates: Certificates owned by the controller which are used for associated services it 

provides.
 Trusted Certificates: Certificates that have been created by a trusted certificate source.
 Untrusted Certificates: Certificates that you have declared as untrusted.
 Quarantined Certificates: Certificates that do not meet the criteria of the other categories.

Successful verification of a certificate in mode TrustedOnly is only possible if the corresponding 
certificate(s) are available in the folder Trusted Certificates.
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Declare a Certificate as Trusted
In order to declare certificates as trusted on your controller, perform the following steps:

Step Action Comment
1 Save the certificate of a device / software that you received from 

the manufacturer to your PC running EcoStruxure Machine 
Expert.

If you did not receive a certificate from 
the manufacturer of your device / soft-
ware, you can obtain it by trying to es-
tablish a connection as described in 
the paragraph Obtaining an Unknown 
Certificate (see page 17).

2 Double-click the certificate.
Result: The Certificate dialog box opens.

–

3 Inspect the certificate carefully in the General tab and decide 
whether you want to declare it as trusted.

–

4 Select the Certification Path tab and verify whether there is only 
one entry.

If there is only one entry in the 
Certification Path tab, then this is a 
self-signed certificate, as for example, 
for the Modicon M262 Logic/Motion 
Controller. You can skip the next two 
steps and proceed with step 7.
If there is a tree structure in the 
Certification Path tab, then this 
certificate has been signed by a CA 
(Certificate Authority). In this case, 
perform the following steps for CA 
certificates.

5 If the certificate has been signed by a CA: Verify each certificate 
from the tree structure including the root CA certificate from the 
Certification Path tab. 

–

6 For each CA certificate of the Certification Path, select the 
certificate and click the View Certificate button.
Result: A new dialog box opens for the selected certificate.

–

7 Select the Details tab and click the Copy to file... button to save 
the certificate on the PC.

–

8 Download the saved certificate files to the Trusted Certificates 
folder of your controller.

Refer to the paragraph Downloading 
Certificate(s) Declared as Trusted to 
the Controller (see page 16).
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Downloading Certificate(s) to the Controller
To save certificates that you have declared as trusted to the folder Trusted Certificates on your 
controller, proceed as follows:

Step Action
1 In EcoStruxure Machine Expert Logic Builder, execute the Security Screen editor from the View menu.
2 In the Security Screen editor, select the Devices tab.
3 Click the button Refresh the list of available devices and their certificate stores.

Result: The display is updated according to the information received from the connected controller.
4 Select the folder Trusted Certificates, and click the Download button.
5 In the Open dialog box, navigate to the folder on your PC running EcoStruxure Machine Expert where 

you saved the certificate file(s).
6 Select the certificate file(s) and click the Open button.

Result: The certificates are downloaded to the controller and are displayed on the right-hand side of the 
Security Screen editor as content of the folder Trusted Certificates.
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Obtaining an Unknown Certificate
If the certificate of a communication partner is not available and you cannot obtain it from the 
manufacturer or another source, proceed as follows:

Step Action Further information
1 Establish a secured connection with 

etCertVerifyMod set to TrustedOnly 
between the client and the server:
 If your application implements a client, 

connect to the server.
 If your application implements a server, open 

the server and accept the incoming 
connection from the client.

Results:
 As the certificate that has been sent by the 

server or client is unknown, the connection 
cannot be established.

 The unknown certificate is stored in the folder 
Quarantined Certificates on your controller.

 If your controller application implements 
a client, the result ConnectionFailed 
may indicate that the certificate that has 
been received from the server is 
unknown.

 If your controller application implements 
a server, the result TlsError may 
indicate that the certificate that has been 
received from the client is unknown.

NOTE: If the folder is empty, the 
communication partner may have not sent 
its certificate. Verify the configuration of the 
remote server or client in order to find out 
whether a certificate can be expected.

2 In EcoStruxure Machine Expert Logic Builder, 
open the Security Screen editor and click the 
button Refresh the list of available devices and 
their certificate stores.

–

3 Select the folder Quarantined Certificates. –
4 Select the certificate from the list on the right-hand side of the Security Screen editor, and click 

the Upload the selected certificate from the device and save it to your PC button.

5 In the Save as dialog box, navigate to a folder on 
your PC running EcoStruxure Machine Expert 
where you want to save the certificate file(s) and 
click the Save button.

–

6 Verify the certificate(s) and decide if you want to 
declare them as trusted as described in the 
paragraph How to Obtain Trusted Certificates 
(see page 15).

–

7 Download the certificate(s) declared as trusted to 
the controller (see page 16).

–
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Considerations When Using Certificates

Considerations
Consider the following when you use certificates for secured communications:
 Administration of certificates is required as they have a limited validity and therefore need to be 

updated in regular intervals. Consider this with respect to the life cycle of your machine or 
control.

 The controller clock is used to verify whether the certificate is still valid. Make sure that the 
controller clock is synchronized with UTC (Universal Time Coordinated) in regular intervals. To 
verify the controller clock, refer to the Services tab of your controller configuration.

 You can also declare certificates as untrusted by saving them to the folder Untrusted 
Certificates in the controller.
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The information provided in this documentation contains general descriptions and/or technical 
characteristics of the performance of the products contained herein. This documentation is not 
intended as a substitute for and is not to be used for determining suitability or reliability of these 
products for specific user applications. It is the duty of any such user or integrator to perform the 
appropriate and complete risk analysis, evaluation and testing of the products with respect to the 
relevant specific application or use thereof. Neither Schneider Electric nor any of its affiliates or 
subsidiaries shall be responsible or liable for misuse of the information contained herein. If you 
have any suggestions for improvements or amendments or have found errors in this publication, 
please notify us. 
You agree not to reproduce, other than for your own personal, noncommercial use, all or part of 
this document on any medium whatsoever without permission of Schneider Electric, given in 
writing. You also agree not to establish any hypertext links to this document or its content. 
Schneider Electric does not grant any right or license for the personal and noncommercial use of 
the document or its content, except for a non-exclusive license to consult it on an "as is" basis, at 
your own risk. All other rights are reserved.
All pertinent state, regional, and local safety regulations must be observed when installing and 
using this product. For reasons of safety and to help ensure compliance with documented system 
data, only the manufacturer should perform repairs to components.
When devices are used for applications with technical safety requirements, the relevant 
instructions must be followed. 
Failure to use Schneider Electric software or approved software with our hardware products may 
result in injury, harm, or improper operating results.
Failure to observe this information can result in injury or equipment damage.
© 2020 Schneider Electric. All rights reserved.
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Safety Information
Important Information

NOTICE
Read these instructions carefully, and look at the equipment to become familiar with the device 
before trying to install, operate, service, or maintain it. The following special messages may appear 
throughout this documentation or on the equipment to warn of potential hazards or to call attention 
to information that clarifies or simplifies a procedure.
EIO0000004065 03/2020 5



PLEASE NOTE
Electrical equipment should be installed, operated, serviced, and maintained only by qualified 
personnel. No responsibility is assumed by Schneider Electric for any consequences arising out of 
the use of this material.
A qualified person is one who has skills and knowledge related to the construction and operation 
of electrical equipment and its installation, and has received safety training to recognize and avoid 
the hazards involved.

BEFORE YOU BEGIN
Do not use this product on machinery lacking effective point-of-operation guarding. Lack of 
effective point-of-operation guarding on a machine can result in serious injury to the operator of 
that machine.

This automation equipment and related software is used to control a variety of industrial processes. 
The type or model of automation equipment suitable for each application will vary depending on 
factors such as the control function required, degree of protection required, production methods, 
unusual conditions, government regulations, etc. In some applications, more than one processor 
may be required, as when backup redundancy is needed.
Only you, the user, machine builder or system integrator can be aware of all the conditions and 
factors present during setup, operation, and maintenance of the machine and, therefore, can 
determine the automation equipment and the related safeties and interlocks which can be properly 
used. When selecting automation and control equipment and related software for a particular 
application, you should refer to the applicable local and national standards and regulations. The 
National Safety Council's Accident Prevention Manual (nationally recognized in the United States 
of America) also provides much useful information.
In some applications, such as packaging machinery, additional operator protection such as point-
of-operation guarding must be provided. This is necessary if the operator's hands and other parts 
of the body are free to enter the pinch points or other hazardous areas and serious injury can occur. 
Software products alone cannot protect an operator from injury. For this reason the software 
cannot be substituted for or take the place of point-of-operation protection.
Ensure that appropriate safeties and mechanical/electrical interlocks related to point-of-operation 
protection have been installed and are operational before placing the equipment into service. All 
interlocks and safeties related to point-of-operation protection must be coordinated with the related 
automation equipment and software programming.

WARNING
UNGUARDED EQUIPMENT
 Do not use this software and related automation equipment on equipment which does not have 

point-of-operation protection.
 Do not reach into machinery during operation.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
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NOTE: Coordination of safeties and mechanical/electrical interlocks for point-of-operation 
protection is outside the scope of the Function Block Library, System User Guide, or other 
implementation referenced in this documentation.

START-UP AND TEST
Before using electrical control and automation equipment for regular operation after installation, 
the system should be given a start-up test by qualified personnel to verify correct operation of the 
equipment. It is important that arrangements for such a check be made and that enough time is 
allowed to perform complete and satisfactory testing.

Follow all start-up tests recommended in the equipment documentation. Store all equipment 
documentation for future references.
Software testing must be done in both simulated and real environments.
Verify that the completed system is free from all short circuits and temporary grounds that are not 
installed according to local regulations (according to the National Electrical Code in the U.S.A, for 
instance). If high-potential voltage testing is necessary, follow recommendations in equipment 
documentation to prevent accidental equipment damage.
Before energizing equipment:
 Remove tools, meters, and debris from equipment.
 Close the equipment enclosure door.
 Remove all temporary grounds from incoming power lines.
 Perform all start-up tests recommended by the manufacturer.

WARNING
EQUIPMENT OPERATION HAZARD
 Verify that all installation and set up procedures have been completed.
 Before operational tests are performed, remove all blocks or other temporary holding means 

used for shipment from all component devices.
 Remove tools, meters, and debris from equipment.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
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OPERATION AND ADJUSTMENTS
The following precautions are from the NEMA Standards Publication ICS 7.1-1995 (English 
version prevails):
 Regardless of the care exercised in the design and manufacture of equipment or in the selection 

and ratings of components, there are hazards that can be encountered if such equipment is 
improperly operated.

 It is sometimes possible to misadjust the equipment and thus produce unsatisfactory or unsafe 
operation. Always use the manufacturer’s instructions as a guide for functional adjustments. 
Personnel who have access to these adjustments should be familiar with the equipment 
manufacturer’s instructions and the machinery used with the electrical equipment.

 Only those operational adjustments actually required by the operator should be accessible to 
the operator. Access to other controls should be restricted to prevent unauthorized changes in 
operating characteristics.
8 EIO0000004065 03/2020



About the Book
At a Glance

Document Scope
This document describes the steps for managing certificates which are applied by the OPC UA 
client provided by the controller.

Validity Note

This document has been updated for the release of EcoStruxureTM Machine Expert V1.2.3.

Related Documents

Document title Reference
Modicon M262 Logic/Motion Controller Hardware 
Guide

EIO0000003659 (ENG); 
EIO0000003660 (FRE); 
EIO0000003661 (GER); 
EIO0000003662 (SPA); 
EIO0000003663 (ITA); 
EIO0000003664 (CHS)

Modicon M262 Logic/Motion Controller Programming 
Guide

EIO0000003651 (ENG); 
EIO0000003652 (FRE); 
EIO0000003653 (GER); 
EIO0000003654 (SPA); 
EIO0000003655 (ITA); 
EIO0000003656 (CHS); 

EcoStruxure Machine Expert Programming Guide EIO0000002854 (ENG);
EIO0000002855 (FRE);
EIO0000002856 (GER);
EIO0000002858 (SPA);
EIO0000002857 (ITA);
EIO0000002859 (CHS)

OpcUaHandling Library Guide EIO0000004021 (ENG);
EIO0000004022 (FRE);
EIO0000004023 (GER);
EIO0000004025 (SPA);
EIO0000004024 (ITA);
EIO0000004026 (CHS);
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Product Related Information

1 For additional information, refer to NEMA ICS 1.1 (latest edition), "Safety Guidelines for the 
Application, Installation, and Maintenance of Solid State Control" and to NEMA ICS 7.1 (latest 
edition), "Safety Standards for Construction and Guide for Selection, Installation and Operation of 
Adjustable-Speed Drive Systems" or their equivalent governing your particular location.

For reasons of Internet security, TCP/IP forwarding is disabled by default. Therefore, you must 
manually enable TCP/IP forwarding. However, doing so may expose your network to possible 
cyberattacks if you do not take additional measures to protect your enterprise. In addition, you may 
be subject to laws and regulations concerning cybersecurity.

WARNING
LOSS OF CONTROL
 The designer of any control scheme must consider the potential failure modes of control paths 

and, for certain critical control functions, provide a means to achieve a safe state during and 
after a path failure. Examples of critical control functions are emergency stop and overtravel 
stop, power outage and restart.

 Separate or redundant control paths must be provided for critical control functions.
 System control paths may include communication links. Consideration must be given to the 

implications of unanticipated transmission delays or failures of the link.
 Observe all accident prevention regulations and local safety guidelines.1
 Each implementation of this equipment must be individually and thoroughly tested for proper 

operation before being placed into service.
Failure to follow these instructions can result in death, serious injury, or equipment damage.

WARNING
UNINTENDED EQUIPMENT OPERATION
 Only use software approved by Schneider Electric for use with this equipment.
 Update your application program every time you change the physical hardware configuration.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
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Terminology Derived from Standards
The technical terms, terminology, symbols and the corresponding descriptions in this manual, or 
that appear in or on the products themselves, are generally derived from the terms or definitions 
of international standards.
In the area of functional safety systems, drives and general automation, this may include, but is not 
limited to, terms such as safety, safety function, safe state, fault, fault reset, malfunction, failure, 
error, error message, dangerous, etc.
Among others, these standards include:

WARNING
UNAUTHENTICATED ACCESS AND SUBSEQUENT NETWORK INTRUSION
 Observe and respect any an all pertinent national, regional and local cybersecurity and/or 

personal data laws and regulations when enabling TCP/IP forwarding on an industrial network.
 Isolate your industrial network from other networks inside your company.
 Protect any network against unintended access by using firewalls, VPN, or other, proven 

security measures.
Failure to follow these instructions can result in death, serious injury, or equipment damage.

Standard Description
IEC 61131-2:2007 Programmable controllers, part 2: Equipment requirements and tests.
ISO 13849-1:2015 Safety of machinery: Safety related parts of control systems.

General principles for design.
EN 61496-1:2013 Safety of machinery: Electro-sensitive protective equipment.

Part 1: General requirements and tests.
ISO 12100:2010 Safety of machinery - General principles for design - Risk assessment and risk 

reduction
EN 60204-1:2006 Safety of machinery - Electrical equipment of machines - Part 1: General 

requirements
ISO 14119:2013 Safety of machinery - Interlocking devices associated with guards - Principles 

for design and selection
ISO 13850:2015 Safety of machinery - Emergency stop - Principles for design
IEC 62061:2015 Safety of machinery - Functional safety of safety-related electrical, electronic, 

and electronic programmable control systems
IEC 61508-1:2010 Functional safety of electrical/electronic/programmable electronic safety-

related systems: General requirements.
IEC 61508-2:2010 Functional safety of electrical/electronic/programmable electronic safety-

related systems: Requirements for electrical/electronic/programmable 
electronic safety-related systems.
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In addition, terms used in the present document may tangentially be used as they are derived from 
other standards such as:

Finally, the term zone of operation may be used in conjunction with the description of specific 
hazards, and is defined as it is for a hazard zone or danger zone in the Machinery Directive 
(2006/42/EC) and ISO 12100:2010.
NOTE: The aforementioned standards may or may not apply to the specific products cited in the 
present documentation. For more information concerning the individual standards applicable to the 
products described herein, see the characteristics tables for those product references.

IEC 61508-3:2010 Functional safety of electrical/electronic/programmable electronic safety-
related systems: Software requirements.

IEC 61784-3:2016 Industrial communication networks - Profiles - Part 3: Functional safety 
fieldbuses - General rules and profile definitions.

2006/42/EC Machinery Directive
2014/30/EU Electromagnetic Compatibility Directive
2014/35/EU Low Voltage Directive

Standard Description
IEC 60034 series Rotating electrical machines
IEC 61800 series Adjustable speed electrical power drive systems
IEC 61158 series Digital data communications for measurement and control – Fieldbus for use in 

industrial control systems

Standard Description
12 EIO0000004065 03/2020



How To Manage Certificates for OPC UA Client

EIO0000004065 03/2020
Managing Certificates for the OPC UA Client

Overview
The OPC UA client provided on the Modicon M262 Logic/Motion Controller supports a secured 
communication using TLS (Transport Layer Security)
In the context of TLS, certificates can be used to verify the identity of the communication partners. 
Certificates are sent during the establishing of a connection, known as the TLS handshake. Only 
if the result of the verification of the certificate is positive can a connection with the communication 
partner be established.
If the connection with the OPC UA server cannot be established, it might be that the result of the 
certificate verification was unsuccessful.
To solve such an issue, consider the following points:
 Verify whether the OPC UA server accepts only connections with trusted certificates. If so, verify 

if the certificate of the controller is added to the list of trusted certificates.
 Verify whether your application is configured to accept only connections with trusted certificates. 

In this case, verify if the received certificate is added to the list of trusted certificates.
The certificate of the communication partner should always be verified for authenticity. This helps 
to prevent unintentionally accepting a connection with an unauthorized device or service. For this, 
the certificate of the communication partner or the certificate of its issuer must be classified as 
trusted beforehand.
The main purpose of this document is to describe two things:
 How you can declare a digital server certificate as trusted for the OPC UA client provided on the 

M262 controller.
 How you can obtain the digital certificate of the controller in order to transfer it manually to the 

M262 server.
EIO0000004065 03/2020 13



General Workflow
The following steps describe the OPC UA client certificate management workflow using manually 
exchanged certificates between client and server:

OPC UA client certificate management workflow using automatically exchanged certificates 
between client and server:

Declare a Digital Certificate as Trusted
For the M262 controller, each unknown or untrusted certificate, which is received with the TLS 
handshake during initialization of an OPC UA connection, is stored in a dedicated folder on the 
controller. This folder as well as the folder containing the trusted certificates can be accessed via 
the Web server of the controller. There you can see the rejected/untrusted certificates and the 
trusted ones. Further you can determine whether a certificate should be declared as trusted.
From the webpage Certificates on the Web server of the controller, you can move the received 
certificates (from OPC UA servers or clients) from the folder Rejected to Trusted. In the same way, 
certificates which are already trusted can be downgraded to rejected (untrusted).
NOTE: For managing the certificates, a secured connection Web server of the controller (via 
https://) is required.

Step Action
1 Obtain the client certificate for the Modicon M262 Logic/Motion Controller. Refer to the section 

below (see page 15).
2 Transfer the Modicon M262 Logic/Motion Controller certificate to the server.
3 Verify that the server trusts the M262 OPC UA client certificate.
4 Obtain the server Certificate.
5 Download the server certificate to the Modicon M262 Logic/Motion Controller. Refer to the 

section below (see page 16).
6 Declare the received server certificate as a trusted certificate. Refer to the section below 

(see page 16).
7 Connect the M262 OPC UA client with the server.

Step Action
1 Attempt to connect the M262 OPC UA client with the server. (Without the trusted server 

certificate this first connection is expected to be unsuccessful but allows the M262 OPC UA 
client to exchange certificates automatically with the server).

2 Verify that the Server trusts the M262 OPC UA client certificate.
3 Declare the received server certificate as a trusted certificate. Refer to the section below 

(see page 16).
4 Connect the M262 OPC UA client with the server.
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For further information about the Web server, refer to Modicon M262 Logic/Motion Controller 
Programming Guide\...\Maintenance: Certificates Submenu (see Modicon M262 Logic/Motion 
Controller, Programming Guide).

Obtain the Controller Certificate
You may need to transfer the digital certificate of the controller manually to the OPC UA server. 
The M262 controller has its own self-signed certificate that is created on the first power-on of the 
controller. This certificate can be obtained using the Security Screen in EcoStruxure Machine 
Expert Logic Builder, proceeding as described in the following table.

Also refer to chapter Security Screen Editor (see How To Manage Certificates on the Controller, 
User Guide) in the How To Manage Certificates User Guide.

Step Action Description/Comment
1 Open the EcoStruxure Machine Expert Logic Builder and 

create a project with the corresponding M262 controller.
-

2 In the EcoStruxure Machine Expert Logic Builder, 
execute the Security Screen editor from the View menu.

-

3 Switch to the Devices tab of the Security Screen. -
4 Click the button Refresh the list of available devices and 

their certificate stores.
Result: The display is updated according to 
the information received from the connected 
controller.

5 Select the Own Certificates tab. -
6 Select the certificate from the list on the right-hand side 

of the Security Screen editor, and click the Upload the 
selected certificate from the device and save it to your 
PC button.

See figure below.

7 In the Save as dialog, navigate to a folder on your PC 
where you want to save the certificate file and click the 
Save button.

-
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Download the Server Certificate to the Modicon M262 Logic/Motion Controller 

Declare a Received Certificate as a Trusted Certificate

Step Action Description/Comment
1 Open EcoStruxure Machine Expert. -
2 Create a project corresponding to your Modicon M262 

Logic/Motion Controller.
-

3 Configure the communication settings of the controller. -
4 Open the Security Screen.

Also refer to chapter Security Screen Editor (see How To 
Manage Certificates on the Controller, User Guide) in the 
How To Manage Certificates User Guide.

NOTE: The Security Screen is represented 
by a shield icon in the lower right corner of the 
EcoStruxure Machine Expert window.

5 Open the Devices tab of the Security Screen. -
6 Click the Refresh button. -
7 Select your M262 controller. -
8 Select the Untrusted Certificates tab. -
9 Click the Download Certificate button (on the left-hand 

side).
-

10 Select the folder on your computer where the server 
certificate is located and select the certificate file to 
download.

-

11 Click the Open button. NOTE:  To update the certificate lists present 
in the Security Screen, a controller reboot is 
required.

Step Action Description/Comment
1 Log in to the Web server of your controller by launching an Internet 

browser and entering the address:
https://<your_controller_ip_address>/

-

2 Enter your user credentials. -
3 Select the Maintenance tab. -
4 Select the Certificates submenu on the left-hand side. -
5 Select the OPC UA certificate in the Rejected list (untrusted). NOTE: Verify that you either 

uploaded the desired certificate 
(through EcoStruxure Machine 
Expert Security Screen) or that 
you have already tried to connect 
to this OPC UA server before.

6 Click the >> button to move the certificate to the Trusted list. -
16 EIO0000004065 03/2020



Declare a Received Certificate as an Untrusted Certificate

NOTE: Move certificates that are no longer active/needed to the Rejected list. This prevents 
unintentional connections to the OPC UA server.

Considerations When Using Certificates

Considerations
Consider the following when you use certificates for secured communications:
 Administration of certificates is required as they have a limited validity and therefore need to be 

updated in regular intervals. Consider this with respect to the life cycle of your machine or 
process.

 The controller clock is used to verify whether the certificate is still valid. Make sure that the 
controller clock is synchronized with UTC (Universal Time Coordinated) in regular intervals. To 
verify the controller clock, refer to the Services tab of your controller configuration.

 You can also declare certificates as untrusted by saving them to the folder Untrusted 
Certificates in the controller.

Step Action Description/Comment
1 Log in to the Web server of your controller by launching an Internet 

browser and entering the address:
https://<your_controller_ip_address>/

-

2 Enter your user credentials. -
3 Select the Maintenance tab. -
4 Select the Certificates submenu on the left-hand side. -
5 Select the OPC UA certificate in the Trusted list. NOTE: Verify that you either 

uploaded the desired 
certificate (through 
EcoStruxure Machine Expert 
Security Screen) or that you 
have already tried to connect 
to this OPC UA server 
before.

6 Click the << button to move the certificate to the Rejected list (untrusted). -
EIO0000004065 03/2020 17
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How To Manage Certificates for OPC UA Client
Glossary
EIO0000004065 03/2020
Glossary
C
certificate

A digital representation of information which at least:
 Identifies the certification authority issuing it.
 Names or identifies its subscriber.
 Contains the public key of the subscriber.
 Identifies its operational period
 Is digitally signed by the certification authority issuing it.

credentials
A qualification, achievement, quality, or aspect the background of a person, especially when used 
to indicate their suitability for something.

T
TLS

(transport layer security) A protocol for encrypted data transfer. Successor of SSL.

trusted
Confidence that an operation, data transaction source, network, or software process can be relied 
upon to behave as expected.

trusted certificate
A certificate that is trusted by the relying party based on secured and authenticated delivery. The 
public keys included in trusted certificates are used to start certification paths. Also known as a 
"trust anchor".

U
untrusted

Not meeting predefined requirements to be trusted.
EIO0000004065 03/2020 19
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